Annotation
Коротко о главном – такова особенность этого издания, которое может стать настольной книгой для начинающих пользователей ArchiCAD. Лаконично, доступно и популярно излагаются основные сведения об этом прикладном архитектурном пакете: описываются интерфейс, команды, базовые операции.
Книга предназначена для тех, кто хочет получить знания в области проектирования и создания архитектурных объектов, научиться решать реальные практические задачи. Издание будет полезно новичкам, желающим быстро освоить инструментарий ArchiCAD, а опытным пользователям книга пригодится в качестве краткого справочника по программе.
Андрей Орлов
ArchiCAD. Начали!
Введение
Данное издание посвящено основным возможностям системы автоматизированного проектирования в области архитектуры и строительства ArchiCAD. Книга предназначена прежде всего начинающим пользователям, поэтому материал приведен в том объеме и расположен в такой последовательности, которые способствуют его быстрому освоению.
Глава 1 рассказывает о принципах разработки проекта в ArchiCAD и основных возможностях системы.
В главе 2 рассматриваются элементы пользовательского интерфейса рабочей среды программы и система помощи, описывающая возможности, инструменты и технологии ArchiCAD.
Главы 3 и 4 содержат принципы построения и редактирования двумерных графических объектов с настройкой их параметров и использованием механизмов точных построений. В них описаны способы выделения объектов, команды изменения формы и относительного расположения графических примитивов, методы привязки и группирования объектов и способы их защиты от непреднамеренного изменения.
Материал главы 5 является краеугольным камнем для понимания принципов проектирования в системе ArchiCAD. Рассмотренные в ней объекты – стены, перекрытия, балки, колонны и крыши – составляют основу любого архитектурного проекта. Овладение настройкой параметров и методами построения этих объектов позволит спроектировать любую виртуальную конструкцию.
Глава 6 описывает работу с библиотечными объектами ArchiCAD. Знание методов построения дверей и окон, лестниц и объектов интерьера, источников освещения и прочих элементов инфраструктуры здания поможет завершить облик пользовательских проектов.
Завершает рассмотрение основных инструментов проектирования описание слоев в главе 7. С их помощью пользователь может создать гибкую систему отображения объектов проекта.
Остальная часть книги посвящена задачам оформления чертежей, их визуализации и распечатке. В главе 8 рассматривается построение размерных и выносных надписей, глава 9 включает в себя описание методов создания деталировочных чертежей, рабочих листов и рисунков.
Завершает рассмотрение инструментов ArchiCAD глава 10, в которой описываются принципы и методы подготовки чертежей, настройка устройств вывода и получение твердых копий.
Приступим к знакомству с системой автоматизированного проектирования ArchiCAD.
От главы коллектива авторов
Высказать замечания и пожелания, задать вопросы по этой книге можно по адресу: AlexanderZhadaev@sigmaplus.mcdir.ru или посетив нашу домашнюю страничку www.sigmaplus.mcdir.ru (здесь вы найдете также дополнительные материалы по книге, сможете принять участие в форуме или пообщаться в чате).
Александр Жадаев
От издательства
Ваши замечания, предложения и вопросы отправляйте по адресу электронной почты: dgurski@minsk.piter.com (издательство «Питер», компьютерная редакция).
Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете подробную информацию о наших книгах.
Глава 1
Быстрый старт
Ни для кого не секрет, что в настоящее время работа конструктора с карандашом в руках считается анахронизмом. Естественно, речь не идет о концептуальных набросках гениального архитектора, но использование кульмана при разработке документации – самая худшая характеристика проектной организации. Однако среди многочисленных автоматизированных систем, используемых в нашей стране, наиболее популярными до сих пор являются так называемые универсальные САПР, обеспечивающие построение чертежей отрисовкой графических примитивов. Таким образом, универсальные МАПР – это всего лишь электронные кульманы, обеспечивающие минимальный уровень автоматизации проектных работ.
В отличие от них ArchiCAD работает со строительными конструкциями: стенами, окнами, балками, перекрытиями, дверями, источниками освещения и т. д. Каждый из перечисленных объектов имеет, естественно, чисто визуальные параметры, необходимые для отображения объекта на чертежах различного вида и масштаба. Кроме того, содержит также сведения, определяющие его характеристики, например материал объекта, его объем и площадь, позволяющие подсчитать материальные затраты или построить реалистичное объемное изображение. Свойства объекта определяют и возможность его взаимодействия с другими объектами, например в стену можно вставить двери и окна, а балку подрезать по скату крыши. Естественно, и процесс проектирования уже не сводится только к черчению, а приобретает совершенно иные черты.
Давайте кратко рассмотрим основные этапы разработки проекта в ArchiCAD.
Процесс проектирования в ArchiCAD
Можно определить следующие этапы разработки проекта в ArchiCAD.
1. Построение виртуальной модели. На этом этапе создаются планы этажей; определяются местоположение, форма и взаимная ориентация несущих стен и перегородок; проектируются двери и окна; кладутся балки и перекрытия; устанавливаются лестницы; проектируется крыша; размещаются мебель и источники освещения; разводятся сети распределительных систем, то есть фактически строится виртуальная модель проекта. Выполнить эту работу можно благодаря наличию в ArchiCAD инструментов трехмерного моделирования и библиотек объектов строительных и других элементов.
2. Оформление чертежей. На этом этапе строятся дополнительные виды (разрезы, фасады, трехмерные проекции и т. д.), наносятся размеры и выносные надписи, условные обозначения, технические требования, проставляются отметки уровней и прочие элементы оформления. Составляются спецификации и сметы, готовятся презентационные материалы для представления заказчику.
3. Подготовка комплекта проектной документации. Конечный итог разработки проекта – передача заказчикам или смежникам проектной документации, которая может быть подготовлена в электронном виде или в виде твердых копий, то есть обычных бумажных чертежей и текстов. В ArchiCAD разработчик может не только скомпоновать любые чертежи из уже готового материала, но даже вообще не заниматься этим делом, а поручить его менее квалифицированному сотруднику, дав тому соответствующие указания.
Таким образом, при работе в ArchiCAD главным является построение объемной модели разрабатываемого объекта, включая детали его интерьера и окружающего пространства, а подготовка документации – только необходимость, которую можно поручить техническим специалистам, не занятым в проектировании напрямую.
Построение объемной модели имеет целью определить структуру проекта, в результате чего появляется возможность получить необходимую информацию об объекте проектирования. Использовать эти сведения можно в любом аспекте: от проведения виртуальных экскурсий до разработки и выполнения графика работ по возведению объекта.
Требования к аппаратно-программному обеспечению
Поскольку ArchiCAD является программой, работающей с трехмерными объектами, то требования, предъявляемые к аппаратно-программному обеспечению компьютера, на котором предполагается установка этой САПР, достаточно высоки.
Аппаратные требования
Аппаратные требования, предъявляемые к компьютеру при установке программы ArchiCAD, следующие:
□ процессоры – Intel Pentium 4, Intel Centrino, Intel Core Duo или совместимые; рекомендуемая тактовая частота – не менее 2 ГГц;
□ оперативная память – требуется 1 Гбайт; для разработки сложных проектов рекомендуется более 1 Гбайт;
□ жесткий диск – установка полной версии ArchiCAD требует 1 Гбайт свободного пространства; не менее 2 Гбайт требуется для разработки сложных проектов с трехмерной визуализацией;
□ монитор – минимальное разрешение 1024 х 768 точек; рекомендуется 1280 х1024;
□ видеокарта – с поддержкой технологии OpenGL и минимальным объемом видеопамяти 64 Мбайт; рекомендуется не менее 128 Мбайт.
ПРИМЕЧАНИЕ
Для знакомства с основными возможностями системы можно установить ArchiCAD и на компьютер с более скромной конфигурацией, но процесс разработки проектов, достаточно сложных по объему и степени детализации, в этом случае будет малопроизводительным.
Программные требования
Программные требования к компьютеру при установке на него программы ArchiCAD следующие:
□ операционная система – Windows XP Pro или Vista Business / Enterprise / Ultimate Edition;
□ поддержка Java 1.6.0 или более поздняя;
□ проигрыватель – QuickTime, версия 7 или более поздняя.
ПРИМЕЧАНИЕ
В процессе работы программа установки ArchiCAD проверяет наличие необходимого программного обеспечения и при его отсутствии самостоятельно устанавливает поддержку Java-версии 1.6.0 и проигрыватель QuickTime 7.
Запуск ArchiCAD
Процесс установки ArchiCAD прост и не требует особых знаний. Не будем останавливаться на нем подробно, а предположим, что программа уже установлена на рабочем компьютере.
Для запуска программы ArchiCAD нужно выполнить одно из следующих действий:
□ выполнить команду Start ► All Programs ► Graphisoft ► ArchiCAD 11 ► ArchiCAD 11 (Пуск ► Все программы ► Graphisoft ► ArchiCAD 11 ► ArchiCAD 11) главного меню Windows;
□ дважды щелкнуть кнопкой мыши на ярлыке программы ArchiCAD
расположенном на Рабочем столе компьютера;
□ дважды щелкнуть кнопкой мыши на значке программы, расположенном на панели быстрого запуска;
□ дважды щелкнуть кнопкой мыши на одном из файлов проекта ArchiCAD.
ПРИМЕЧАНИЕ
Второй и третий способы будут доступны, если создание используемых ярлыков было предусмотрено при установке ArchiCAD. В противном случае можно самостоятельно создать необходимые ярлыки, используя стандартные средства Windows.
Прежде чем рассматривать процесс запуска ArchiCAD, нужно определить понятие «проект». Под проектом понимается совокупность всех элементов конкретной разработки: построенные объекты виртуальной модели здания, созданные чертежи и рисунки, различные виды. Другими словами, проект – это все, что является итогом труда разработчика, и кроме того, это все настройки среды разработки: свойства и атрибуты элементов, состав и расположение панелей инструментов, ссылки на используемые при разработке библиотечные объекты и т. п. Все составляющие элементы проекта сохраняются в едином файле с расширением PLN.
При первом запуске ArchiCAD на экране появится окно Start ArchiCAD (Запуск ArchiCAD) (рис. 1.1).
Окно запуска разделено на пять областей. В верхней части окна расположен переключатель выбора режима запуска, который можно установить в одно из трех имеющихся положений. Выбор любого из этих положений изменяет состав доступных элементов управления.
Рис. 1.1. Выбор параметров проекта при запуске ArchiCAD
Установка, используемая по умолчанию, – Create a New Project (Создать новый проект). При выборе этого положения во второй области окна станет доступным переключатель Set up Project Settings (Установить параметры проекта), предназначенный для выбора шаблона настроек элементов проекта. Настройки включают в себя определения типов линий, единиц измерения, рисунков штриховок и прочих параметров элементов проекта, сохраненных в файле с расширением TPL.
Если установить переключатель выбора режима запуска в положение Open a Project (Открыть проект), то во второй области окна вместо переключателя Set up Project Settings (Установить параметры проекта) появляется переключатель You can (Вы можете), который можно установить в следующие положения:
□ Browse for a Project (Выбрать проект) – при выборе этого значения кнопка New (Новый) заменяется кнопкой Browse (Просмотр), нажатие которой открывает навигационное окно файловой системы Windows, используя элементы управления которого можно выбрать для открытия необходимый файл;
□ Select a recent Project (Выбрать последний проект) – предназначено для открытия одного из последних редактировавшихся проектов, список которых становится доступным для выбора; кнопка Browse (Просмотр) в этом случае заменяется кнопкой Open (Открыть).
Третье положение переключателя выбора режима запуска – Sign In to a Team Project (Присоединиться к совместному проекту) – предназначено для коллективной работы, которая в данной книге подробно не рассматривается.
В третьей области окна можно выбрать профиль рабочей среды. Профилем называется совокупность настроек элементов интерфейса, к которым относятся состав и положение меню, размещение и состав панелей инструментов, окон, настройки цветовой палитры, места размещения файлов и т. д. Требуемый профиль выбирается из открывающегося списка.
В четвертой области расположены кнопки, одна из которых, используемая для открытия проекта, описана выше, другая – Qiut ArchiCAD (Покинуть ArchiCAD) – предназначена для прерывания запуска программы.
При установке флажка Do not Display this Dialog Next Time (Не показывать этот диалог при следующем запуске), расположенного в последней области, рассматриваемое окно при запуске ArchiCAD показываться не будет. Функции создания и открытия проекта, выбора шаблонов и профилей в этом случае будут доступны с помощью соответствующих инструментов рабочей среды ArchiCAD.
При самом первом запуске нужно, естественно, оставить все установки по умолчанию. Нажатие кнопки New (Новый) приведет к созданию нового проекта, открытого в рабочей среде программы ArchiCAD (рис. 1.2).
О том, как сориентироваться в пользовательском интерфейсе ArchiCAD, см. в гл. 2. Сейчас рассмотрим основные инструменты, с помощью которых можно создать проект, сохранить его, а затем открыть для последующего редактирования. Эти инструменты хорошо известны пользователям большинства программ Windows.
Создание, сохранение и открытие проекта
Создать новый файл проекта можно с помощью одного из следующих действий:
Рис. 1.2. Рабочая среда программы ArchiCAD
□ нажать кнопку
расположенную на панели инструментов Standard (Стандартная);
□ выполнить команду File ► New (Файл ► Создать) меню ArchiCAD;
□ нажать комбинацию клавиш Ctrl+N.
СОВЕТ
Рассматриваемая в книге оригинальная версия ArchiCAD чувствительна к установленной раскладке клавиатуры. Если нажатие комбинации клавиш не приводит к необходимому эффекту, то, возможно, у вас активна кириллица. Переключитесь на английский язык. В локализованной версии программы эта проблема отсутствует.
Для сохранения редактируемого проекта можно использовать следующие способы:
□ нажать кнопку
расположенную на панели инструментов Standard (Стандартная);
□ выполнить команду File ► Save (Файл ► Сохранить) меню ArchiCAD;
□ нажать комбинацию клавиш Ctrl+S.
После выбора действия по сохранению проекта появляется навигационное окно Windows, используя элементы интерфейса которого необходимо выбрать место расположения и ввести имя файла, под которым будет сохранен проект.
Выше было упомянуто о возможности сохранения проекта ArchiCAD в форматах других программ. Для этого предназначена команда главного меню File ► Save as (Файл ► Сохранить как) или комбинация клавиш Ctrl+Shift+S. Выполнив одно их этих действий, пользователь получит возможность выбрать из списка типов файлов навигационного окна (рис. 1.3) необходимый формат сохраняемого проекта.
Рис. 1.3. Сохранение файла проекта в другом формате
Чтобы открыть существующий проект, нужно выполнить одно из следующих действий:
□ нажать кнопку
на панели инструментов;
□ выполнить команду File ► Open (Файл ► Открыть) меню ArchiCAD;
□ нажать комбинацию клавиш Ctrl+0.
Из соответствующих списков открывшегося навигационного окна необходимо выбрать имя и тип открываемого файла проекта. По умолчанию файлы с сохраненными проектами имеют расширение PLN.
В окне программы можно одновременно работать только с одним проектом. Если необходимо открыть несколько проектов, то нужно запустить соответствующее количество копий ArchiCAD, в каждой из которых открыть свой проект.
Варианты сохранения проекта
По умолчанию проект ArchiCAD сохраняется в формате PLN, но при этом в файл проекта записываются только ссылки на использованные в проекте библиотечные объекты, текстуры и фоновые рисунки. По этой причине при переносе файла проекта на другой компьютер эти объекты исчезнут. Чтобы сохранить полную информацию проекта, необходимо выбирать формат PLA.
Проект, включая значения параметров его инструментов и объектов, можно сохранить в виде шаблона, файл которого имеет расширение TPL. На базе имеющихся шаблонов можно создавать другие проекты.
В проект можно вставлять содержимое других проектов или файлов. Объем сохраняемого файла можно уменьшить, используя сжатие.
Обо всем вышесказанном можно прочесть на странице системы помощи программы, где в левой части окна на вкладке Содержание в древовидном списке нужно открыть папку Configuration (Конфигурация), а в ней найти папку Managing Projects (Управление проектами). Чтобы попасть на страницу помощи, следует выполнить в главном окне программы команду Help ► ArchiCAD Help (Помощь ► Система помощи).
Подробное описание форматов для сохранения файла проекта можно найти на этой же странице, если открыть в левой части окна папку User Interface Reference (Справочник по интерфейсу пользователя), в ней перейти в папку Dialog Boxes (Диалоговые окна) и выбрать здесь файл File Types Saved by ArchiCAD (Типы сохраняемых файлов).
В первой главе основное внимание было уделено описанию возможностей этой системы и тех преимуществ, которые получает разработчик по сравнению с ручным проектированием или работой в среде универсальных САПР. В главе приведены требования к аппаратно-программному обеспечению, необходимому для установки и эксплуатации ArchiCAD, описан процесс запуска системы с выбором вариантов загрузки, дано понятие проекта и рассмотрены действия по его созданию, сохранению и открытию.
Глава 2
Знакомство с рабочим окном и инструментами ArchiCAD
Пользователь взаимодействует с программой с помощью элементов управления, совокупность которых называется графическим интерфейсом пользователя. В интерфейсе ArchiCAD используются стандартные элементы управления, знакомые любому пользователю Windows, поэтому освоение программы не вызовет серьезных затруд нений.
Загрузите программу ArchiCAD одним из рассмотренных в главе 1 способов, используя настройки, установленные по умолчанию, то есть нажимая кнопку ОК в любом окне, отображаемом при загрузке программы. По окончании загрузки на экране отобразится стартовое окно ArchiCAD (рис. 2.1).
Рассмотрим эти элементы более подробно.
Главное меню
Принцип действия главного меню ArchiCAD (рис. 2.2) не отличается от меню любой другой программы Windows. Щелчок на меню открывает подменю и команды, предоставляющие доступ к инструментам и функциям программы.
Главное меню ArchiCAD включает множество команд, с которыми мы будем работать на протяжении всей книги. Для быстрого вызова наиболее часто употребляемых команд предусмотрен механизм использования горячих клавиш. Просмотреть полный список действующих в среде программы горячих клавиш можно, выполнив следующую последовательность действий.
1. Выполните команду главного меню Options ► Work Environment ► Keyboard Shortcuts (Параметры ► Рабочая среда ► Горячие клавиши) – откроется окно настройки рабочей среды ArchiCAD Work Environment (Рабочая среда) с активным пунктом Keyboard Shortcuts (Горячие клавиши) (рис. 2.3).
2. Нажмите кнопку Show Shortcut List in Browser (Показать список горячих клавиш в браузере), расположенную в разделе Keyboard Shortcut Preview (Просмотр горячих клавиш), который находится внизу правой части окна настройки рабочей среды. В окне браузера, установленного в операционной системе по умолчанию, откроется список горячих клавиш среды ArchiCAD (рис. 2.4).
Рис. 2.1. Элементы интерфейса ArchiCAD
Рис. 2.2. Элементы главного меню ArchiCAD
Рис. 2.3. Окно настройки рабочей среды ArchiCAD
Рис. 2.4. Список горячих клавиш ArchiCAD
Панели инструментов
Панель инструментов – область графического интерфейса, содержащая элементы управления, выполненные чаще всего в виде кнопок, с помощью которых можно вызвать необходимую команду или меню. С ArchiCAD поставляется 15 предварительно настроенных панелей инструментов. Мы будем знакомиться с панелями на протяжении всей книги, используя их по мере надобности.
Для включения / выключения отображения необходимых панелей инструментов выполните команду меню Window ► Toolbars (Окно ► Панели инструментов) и в отобразившемся списке панелей инструментов щелкните кнопкой мыши на наименовании необходимой панели. Слева от названия панели появится значок, свидетельствующий о ее активности, а сама панель отобразится на экране. Если щелкнуть на активной панели, то она отключится.
Вид панели инструментов зависит от ее положения. Если панель находится у границы окна ArchiCAD, то она притягивается к границе и располагается вдоль нее. В верхней части вертикально расположенной панели и у левого края горизонтально расположенной панели находится заголовок панели, имеющий вид линии, состоящей из точек. При положении панели инструментов внутри окна ArchiCAD или за его пределами панель имеет вид окна Windows.
Заголовок панели инструментов предназначен для ее перемещения по экрану. Чтобы изменить место расположения панели, щелкните кнопкой мыши на области заголовка и, не отпуская кнопку мыши, перетащите панель на новое место.
Палитры
Как и панели, палитры предназначены для размещения различных элементов управления, поэтому принципиального различия между этими элементами пользовательского интерфейса нет. Основное отличие между панелями инструментов и палитрами в том, что последние содержат более разнообразные инструменты и, следовательно, имеют более гибкие возможности управления ими и собственным внешним видом.
Для включения / выключения отображения палитры на экране предназначены следующие действия.
□ Выполните команду главного меню ArchiCAD Window ► Palettes (Окно ► Палитры) – появится список стандартных палитр (рис. 2.5). Активные палитры помечены квадратом с затемненным фоном.
□ Щелкните кнопкой мыши на неактивной палитре, чтобы отобразить ее на экране, щелчок на активной панели скроет ее.
Рассмотрим основной инструментарий и некоторые свойства стандартных палитр. Меню палитр разбито на пять областей, в которых сгруппированы параметры активации па литр различного функционального назначения.
□ В первой области, расположенной в верхней части меню, находится параметр Show Main Palettes Only (Показать только основные палитры), выбор которого отобразит палитры Toolbox (Инструменты), Info Box (Информационная палитра), Quick Options (Быстрый доступ) и Navigator (Навигатор), включающие в себя основные инструменты ArchiCAD и отображающиеся по умолчанию. Остальные палитры будут убраны с экрана монитора.
□ Во второй области находятся параметры активации палитр, содержащих инструменты создания объектов виртуальной модели и настройки их параметров.
□ В третьей области меню палитр расположены параметры активации палитр, содержащих инструменты для работы со структурой разрабатываемого проекта и объектами его оформления.
□ В четвертой области рассматриваемого меню сгруппированы параметры активации палитр, содержащих вспомогательные инструменты для работы с проектом.
□ В последней области меню располагаются параметры активации палитр, обеспечивающих оперативное управление работой инструментов программы.
Более подробно об отдельных элементах интерфейса будет рассказываться по мере рассмотрения связанных с ними функций.
Рис. 2.5. Список палитр
Система помощи
Вместе с программой ArchiCAD поставляется система интерактивной контекстно зависимой помощи, предназначенная для получения пользователем оперативной справочной информации. Контекстно зависимой принято называть информацию, связанную с активным объектом.
Для просмотра состава системы помощи ArchiCAD нужно выбрать пункт Help (Помощь) основного меню программы. Откроется список параметров вызова различных вариантов помощи, сгруппированных в пяти разделах меню (рис. 2.6).
Рис. 2.6. Меню системы помощи ArchiCAD
Наиболее полезно для большинства пользователей справочное руководство по ArchiCAD, открываемое с помощью пункта AC11 Reference Guide (Справочное руководство по ArchiCAD). Руководство оформлено в виде книги, содержащей более четырехсот страниц, в которой описаны основные возможности программы. В справочной системе имеется и два руководства, предназначенных для высококвалифицированных специалистов, а также описание новых возможностей системы.
Параметр Hide Tool Tips (Скрыть всплывающие подсказки), расположенный в первом разделе меню помощи, отключает механизм отображения всплывающих подсказок, которые появляются при подведении и задержке на некоторое время указателя мыши на каком-либо объекте ArchiCAD (рис. 2.7).
Рис. 2.7. Всплывающая подсказка
После отключения механизма отображения всплывающих подсказок параметр Hide Tool Tips (Скрыть всплывающие подсказки) будет заменен в меню параметром Show Tool Tips (По казать всплывающие подсказки), который можно использовать, что бы включить отображение всплывающих подсказок.
Рассмотрим параметр ArchiCAD Help (Система помощи), предназначенный для вызова системы интерактивной помощи ArchiCAD. Выполните команду Help ► ArchiCAD Help (Помощь ► Система помощи) или нажмите клавишу F1 – будет запущен браузер, установленный в операционной системе по умолчанию, в окне которого откроется главная страница системы помощи (рис. 2.8).
Рис. 2.8. Система помощи ArchiCAD
Страница системы помощи разделена на две области. В левой расположена система навигации (поиска информации), в правой отображаются найденные сведения. Инструменты системы поиска информации сгруппированы на трех вкладках в левой области.
На вкладке Содержание представлена иерархическая структура системы помощи. Содержание руководства разбито на девять разделов. Чтобы просмотреть содержимое какого-либо раздела, необходимо щелкнуть на названии элемента содержания или значке в виде закрытой книги, расположенном слева от названия. После открытия выбранного раздела в правой области страницы помощи появится связанная с ним информация.
В дополнение к стандартным элементам управления панели инструментов браузера над областью отображения найденной информации добавлены шесть следующих кнопок.
Показать в содержании – если нажать эту кнопку, то элемент, информация о котором отображена в окне, будет подсвечен в содержании руководства.
Назад – переход к предыдущему элементу содержания.
Далее – переход к следующему элементу содержания.
Дополнительная информация – кнопка становится доступной, если существует дополнительная информация, связанная с содержимым активного окна системы помощи. Нажатие этой кнопки открывает окно, содержащее ссылки на дополнительную информацию.
Электронная почта – вызов клиента электронной почты для отправки разработчикам комментариев к содержимому окна помощи. Автоматически заполняются электронный адрес получателя и тема письма, которой становится заголовок активного окна системы помощи ArchiCAD.
Печать – распечатка найденной информации.
Система помощи ArchiCAD имеет механизм открывающегося текста. При щелчке кнопкой мыши на элементе системы помощи, который заканчивается стрелкой, направленной вправо (рис. 2.9, а), элемент раскрывается, отображая связанный с ним текст (рис. 2.9, б).
Рис. 2.9. Механизм открывающегося текста: элемент системы, заканчивающийся стрелкой (а); связанный с элементом текст (б)
На вкладке Указатель расположены элементы управления, предназначенные для поиска информации, упорядоченной по алфавиту, а вкладка Поиск предназначена для контекстного поиска информации. Работа с этими вкладками достаточно тривиальна.
Наиболее полезный для пользователя и самый оперативный механизм – это контекстная помощь. Ее основное преимущество перед описанными механизмами поиска в том, что при вызове контекстной помощи автоматически ищется и отображается информация, непосредственно связанная с активным объектом.
Чтобы получить контекстную помощь, нужно щелкнуть правой кнопкой мыши на каком-либо объекте интерфейса – откроется его контекстное меню, в котором следует выбрать пункт What’s This? (Что это?). Информация, относящаяся именно к этому объекту, будет найдена и отображена в окне браузера.
К сожалению, основной язык системы помощи ArchiCAD – английский. Для получения информации на родном языке необходимо приобрести локализованную версию этой программы.
В этой главе были рассмотрены основные элементы интерфейса ArchiCAD – параметры меню, панели инструментов и палитры, с помощью которых организована среда разработки рассматриваемой системы проектирования. Мы узнали о месте нахождения и назначении основных инструментов ArchiCAD, научились организовывать рабочее место путем отображения необходимых элементов управления и размещения их в наиболее удобных для работы местах.
Кроме того, в главе была рассмотрена система интерактивной помощи, содержащая описание изучаемой программы и механизмы поиска необходимой информации.
Глава 3
Черчение двумерных фигур
Начнем знакомство с инструментарием ArchiCAD с принципов построения так называемых графических примитивов, к которым относятся двумерные фигуры, используемые при построении рисунков или чертежей: линии, дуги, прямоугольники, окружности, произвольные кривые. Кроме того, к примитивам отнесем и некоторые комбинации вышеназванных элементов, имеющие самостоятельное назначение и методы отрисовки, например штриховки или текст.
Построение линий
Активировать режим построения линий можно, нажав кнопку Line (Линия)
в разделе Document (Документ) палитры инструментов. Элементы управления инструмента Line (Линия) будут отображены на палитре Info Box (Информационная палитра). Поскольку при активизации любого инструмента элементы управления настройкой его параметров появляются на информационной палитре, рассмотрим принцип размещения этих элементов по умолчанию на палитре Info Box (Информационная палитра) (рис. 3.1).
Рис. 3.1. Структура информационной палитры
Области логического распределения элементов управления отделены друг от друга вертикальными границами.
Рассмотрим области по порядку.
□ Default Settings (Настройки по умолчанию) – область содержит кноп ку вызова соответствующего окна. Вид кнопки меняется в зависимости от выбранного инструмента и совпадает с видом кнопки этого инструмента, расположенной на палитре ToolBox (Палитра инструментов).
□ Layers (Слои) – в этой области находятся кнопки управления положением и видимостью примитива или объекта, созданного с помощью выбранного инструмента.
□ Geometry Method (Метод построения) – если объект имеет различные способы построения, то в этой области расположены кнопки вызова соответствующих инструментов.
□ После области методов построения идут элементы управления, пред назначенные для настройки конкретных параметров активного инструмента. Вследствие разнообразия создаваемых объектов состав и положение этих управляющих элементов будут изменяться. Для рассматриваемых в этой главе плоских графических примитивов общими будут инструменты выбора типа, толщины и цвета линии отрисовки, располагаемые за областью методов построения.
□ В нижней части информационной палитры расположена линейка горизонтальной прокрутки, с помощью которой можно увидеть остальные элементы управления, не уместившиеся на экране.
Info Box (Информационная палитра) предназначена для быстрой установки наиболее востребованных параметров строящегося или редактируемого объекта. Полный список параметров находится в окне настроек объекта по умолчанию, которое вызывается нажатием кнопки, расположенной в первой области информационной палитры. Для инструмента Line (Линия) это окно называется Line Default Settings (Настройки параметров линии по умолчанию) (рис. 3.2), а кнопка его вызова имеет вид
Большая по размеру кнопка Line Type (Тип линии), расположенная в разделе General Settings (Общие настройки), предназначена для выбора типа отрисовываемой линии. Надпись и рисунок на кнопке соответствуют текущей установке типа линии. Нажатие этой кнопки открывает список типов линий (рис. 3.3), из которого можно выбрать необходимый параметр, щелкнув кнопкой мыши на соответствующем рисунке.
При перемещении указателя мыши по объектам списка надпись в верхней строке списка, соответствующая текущему положению указателя, а также надпись на кнопке Line Type (Тип линии) будут изменяться и примут окончательный вид после выбора типа линии.
Рис. 3.2. Окно настройки параметров линии по умолчанию
Рис. 3.3. Выбор типа линии
Справа от кнопки выбора типа линии расположены элементы управления выбором пера. Пером называется обозначаемая номером совокупность толщины и цвета линии. Эти параметры устанавливаются кнопкой Line Pen (Тип пера)
расположенной справа от текстового поля с номером пера. Использование этой кнопки открывает палитру перьев (рис. 3.4).
Чтобы выбрать необходимое перо, нужно выполнить следующие действия.
1. Поместить указатель мыши на один из цветных квадратиков палитры – в левом верхнем углу палитры отобразится информация об указанном пере: его номер, ширина отрисовываемой линии в миллиметрах и пунктах и наименование пера.
2. Щелкнуть кнопкой мыши на выбранном элементе – его параметры станут параметрами текущего пера.
При построении линии можно указать так называемые маркеры – элементы, которые могут быть отрисованы на концах линии. Наличие и вид маркеров определяются с помощью кнопок Arrowheads (Маркеры), расположенных в нижней части раздела General Settings (Общие настройки), отделенной от верхней части горизонтальной чертой-разделителем.
Рис. 3.4. Палитра перьев
Таких кнопок четыре:
Arrowheads – None (Нет маркеров) – линия без маркеров;
Arrowheads – Start (Начать с маркера) – линия начинается с маркера;
Arrowheads – End (Закончить маркером) – линия заканчивается маркером;
Arrowheads – Both (Маркеры с обоих концов) – маркеры на обоих концах линии.
Если выбрана маркированная линия, то становятся доступными расположенные справа от этих кнопок поле для ввода размера маркера и кнопка выбора пера для его отрисовки. Это дает возможность отрисовки маркера, например, цветом, отличным от цвета линии. Вид маркера выбирается из группы переключателей (рис. 3.5), которая открывается нажатием кнопки Select Arrowhead (Выбор маркера)
расположенной под кнопками Arrowheads (Маркеры).
Рис. 3.5. Переключатели выбора вида маркера
Если установить флажок Uniform Settings for Line Tools (Единые параметры для всех линий), расположенный над разделом General Settings (Общие настройки), то установленные для линии параметры будут действительны и для других двумерных элементов: дуг, окружностей, полилиний и сплайнов.
В левом верхнем углу окна Line Default Settings (Настройки параметров линии по умолчанию) расположена кнопка Favorites (Избранное) – это элемент запуска одного из самых полезных инструментов, использующихся для упрощения и ускорения работы пользователя.
Предположим, нужно использовать для основных линий чертежа сплошную черную линию толщиной 0,35 мм, для вспомогательных – сплошную черную линию толщиной 0,18 мм, для осевых – синюю штрихпунктирную линию толщиной 0,13 мм, а для размерных линий – такую же линию, как для вспомогательных, но красного цвета и с маркером в виде стрелки на конце линии. При обычной работе каждый раз при необходимости смены типа линии придется изменять нужные параметры в информационной палитре или окне настройки. C помощью инструмента Favorites (Избранное) можно сохранить настройки для каждого типа линии, чтобы потом вызывать их одним щелчком кнопкой мыши. Для этого необходимо выполнить следующую последовательность действий.
1. Нажать кнопку Line (Линия)
палитры инструментов, чтобы активировать инструмент построения линий.
2. Открыть окно настройки параметров линий, нажав кнопку
информационной панели.
3. Установить необходимые настройки параметров для основной линии.
4. Нажать кнопку Favorites (Избранное) – откроется окно Apply Favorites (Применить избранное) со списком имеющихся сохраненных настроек (рис. 3.6).
5. Нажать в данном окне кнопку Save Current Settings as Favorite (Сохранить текущие настройки в качестве избранных) – откроется окно New Favorite (Добавить настройки) (рис. 3.7).
6. Указать в данном окне имя, под которым нужно сохранить текущие настройки параметров линии, например Основная.
7. Нажать кнопку OK – окно New Favorite (Добавить настройки) закроется, а в списке окна диалога Apply Favorites (Применить избранное) (см. рис. 3.6) появится новый элемент с именем Основная.
8. Нажать кнопку OK – окно Apply Favorites (Применить избранное) закроется.
9. Повторить пп. 3-8 необходимое количество раз, изменяя комбинации параметров линий и сохраняя их под соответствующими именами.
Рис. 3.6. Список сохраненных настроек линий
Рис. 3.7. Ввод имени нового элемента списка избранных настроек
10. Закрыть окно Line Default Settings (Настройки параметров линии по умолчанию), нажав кнопку OK.
Чтобы установить необходимую комбинацию параметров линии, нужно выполнить такую последовательность действий.
1. Открыть окно Line Default Settings (Настройки параметров линии по умолчанию).
2. Нажать кнопку Favorites (Избранное) – откроется окно Apply Favorites (Применить избранное) (см. рис. 3.6).
3. Щелкнуть кнопкой мыши на элементе списка с необходимой комбинацией настроек.
4. Нажать кнопку Apply (Применить) – текущие параметры линии по умолчанию заменятся параметрами выбранной комбинации.
ВНИМАНИЕ
Механизм сохранения параметров действует не только для линий, но и для любого объекта ArchiCAD. Используйте сохранение параметров объектов для повышения эффективности своей работы.
Инструмент построения линий позволяет строить не только линии, но и другие графические примитивы. Это видно по составу следующих кнопок, расположенных в области Geometry Method (Метод построения) информационной палитры:
– построение линии с указанием координат начальной и конечной точек;
– построение полилинии, то есть контура, состоящего из последовательно соединенных отрезков и дуг;
– построение прямоугольника с указанием координат начальной и конечной точек его диагонали;
– построение прямоугольника с указанием координат начальной и конечной точек его диагонали и угла наклона основания к горизонтальной оси.
Для того чтобы построить линию, необходимо выбрать метод отрисовки линии по координатам ее начала и конца, щелкнув на кнопке
области Geometry Method (Метод построения) информационной палитры, и выполнить приведенную ниже последовательность действий.
1. Щелкнуть кнопкой мыши на свободном месте рабочего поля – в указанном месте появится маркер в виде косого креста, определяющий положение начальной точки линии.
2. Переместить указатель мыши до места, где должен находиться конец линии. В процессе перемещения от маркера начала линии до указателя мыши тянется «резиновая нить», отображающая текущее положение линии. Синхронно с указателем мыши перемещается полупрозрачное табло, на котором отображаются текущая длина отрезка и угол его наклона относительно горизонтальной оси (рис. 3.8).
3. Щелкнуть кнопкой мыши на точке, где должен находиться конец линии – на рабочем поле будет вычерчена линия с установленными в окне Line Default Settings (Настройки параметров линии по умолчанию) или палитры Info Box (Информационная палитра) настройками.
Рис. 3.8. Построение линии по двум точкам
При построении линии на экране присутствуют не только «резиновая нить» и информационное табло, но и другие визуальные объекты. Все они информируют пользователя о текущем состоянии системы, что позволяет полностью контролировать процесс работы.
Построение дуг, окружностей и эллипсов
Для активации режима построения дуг, окружностей и эллипсов нужно нажать кнопку Arc / Circle (Дуга / Окружность)
расположенную в разделе Document (Документ) палитры инструментов. Элементы управления настройкой параметров этого инструмента будут отображены на палитре Info Box (Информационная палитра) (рис. 3.9).
Рис. 3.9. Информационная палитра в режиме построения окружностей, дуг и эллипсов
Если сравнить вид отображенной информационной панели с видом аналогичной панели инструмента Line (Линия) (см. рис. 3.1), то видно, что отличается только вид кнопки вызова окна настройки параметров по умолчанию
и состав инструментов области Geometry Method (Метод построения). Практически идентичен и состав элементов управления окна установки параметров, которое называется Arc / Circle Default Settings (Настройки параметров дуги / окружности по умолчанию).
Построение дуги или окружности
Для построения дуги или окружности используется первая кнопка области Geometry Method (Метод построения) информационной палитры. При первом обращении к инструменту построения дуг и окружностей данная кнопка имеет вид
но может изменять его в зависимости от установленного на данный момент метода построения. В правом нижнем углу кнопки имеется стрелка, свидетельствующая о том, что щелчок кнопкой мыши на данном элементе управления вызывает дополнительный набор инструментов для уточнения способа выполнения действия.
Нажатие данной кнопки после небольшой задержки открывает панель кнопок (рис. 3.10), с помощью которых можно вы брать необходимый метод построения.
Рис. 3.10. Кнопки выбора метода построения дуг/окружностей
В соответствии с количеством кнопок существует три метода построения дуг и окружностей:
– указанием центра, радиуса, начальной и конечной точек;
– указанием трех произвольных точек;
– указанием двух касательных и точки.
Для построения дуги или окружности по центру, радиусу и конечным точкам нужно активировать первый метод построения, нажав кнопку
и выполнив следующую последовательность действий.
1. Укажите точку, в которой будет находиться центр строящейся дуги или окружности. Для этого щелкните кнопкой мыши на свободном месте рабочего поля – в указанном месте появится маркер в виде косого креста.
2. Определите радиус строящегося элемента, переместив указатель мыши на необходимое расстояние. При выполнении этого действия на экране будет динамически отрисовываться окружность, а также подобно действию построения линии отображаться «резиновая нить», указывающая текущее положение радиуса, и табло с информацией о его длине (рис. 3.11).
Рис. 3.11. Определение радиуса дуги / окружности
3. Щелчком кнопки мыши определите начальную точку дуги. Вид табло изменится: поскольку длина радиуса зафиксирована, вместо информации о ней появятся сведения о величине угла дуги (рис. 3.12).
4. Если ваша цель – построение окружности, то щелкните кнопкой мы ши на той же точке. Поскольку у окружности начальная и конечная точки совпадают, то на этом построение окружности заканчивается.
Рис. 3.12. Определение начальной точки дуги
5. Если нужно построить дугу, то следует продолжить процесс построения. Укажите положение конечной точки дуги перемещением указателя мыши. При выполнении действия текущее положение дуги будет динамически отображаться на экране. Синхронно с указателем мыши будет перемещаться и табло с текущим значением угла дуги (рис. 3.13).
6. Щелкните кнопкой мыши для фиксации конечной точки дуги. На рабочем поле будет вычерчена дуга с параметрами, установленными с помощью элементов управления палитры Info Box (Информационная палитра) или окна Arc / Circle Default Settings (Настройки параметров дуги / окружности по умолчанию) (рис. 3.14).
Рис. 3.13. Определение конечной точки дуги
Рис. 3.14. Результат построения дуги
Остальные методы построения окружностей и дуг можно освоить с помощью справочной системы. Рассмотрим следующее действие – построение эллипсов.
Построение эллипсов
Чтобы выбрать метод построения эллипсов, нужно нажать кнопку
расположенную справа от кнопки построения дуг / окружностей. Внешний вид кнопки может меняться в зависимости от установленного метода построения. После нажатия кнопки на экране с некоторой задержкой появятся три кнопки (рис. 3.15), позволяющие выбрать необходимый метод построения.
Как и для дуг / окружностей, в ArchiCAD имеется три метода построения эллипсов:
– указанием диагонали описанного прямоугольника; в этом случае длина и ширина прямоугольника являются длинами большой и малой осей эллипса;
– указанием полудиагонали описанного прямоугольника; метод подобен построению окружности по центру и радиусу;
– указанием двух радиусов.
Для построения эллипса следует выбрать первый метод, нажав кнопку
и выполнив следующую последовательность действий.
1. Щелкните кнопкой мыши на свободном месте рабочего поля – в указанном месте появится маркер в виде косого креста. Эта точка будет первой точкой диагонали прямоугольника, описанного вокруг отрисовываемого эллипса.
2. Укажите вторую точку диагонали, перемещая указатель мыши. В процессе выполнения действия на экране точечной линией будет отрисовываться прямоугольник с вписанным в него эллипсом (рис. 3.16). В информационном табло будут динамически отображаться длина и ширина прямоугольника, фактически являющиеся длинами осей эллипса.
Рис. 3.15. Кнопки методов построения эллипсов
Рис. 3.16. Построение эллипса указанием диагонали описанного прямоугольника
3. Щелкните кнопкой мыши для фиксации второй точки диагонали – эллипс построен.
Чтобы построить эллипс по методу полудиагонали описанного прямоугольника, нужно нажать кнопку
и выполнить такую последовательность действий.
1. Укажите первую точку полудиагонали прямоугольника, описываемого вокруг эллипса, щелкнув кнопкой мыши на свободном месте рабочего поля, – в указанном месте появится маркер в виде косого креста. Эта точка будет являться точкой пересечения диагоналей прямоугольника или центром эллипса.
2. Укажите вторую точку полудиагонали (угол описанного вокруг эллипса прямоугольника), перемещая указатель мыши. При перемещении указателя на экране будет отрисовываться эллипс. Информационное табло укажет длины полуосей эллипса.
3. Зафиксируйте вторую точку полудиагонали щелчком кнопкой мыши – эллипс построен.
Построение полилиний
Полилинией называется контур, состоящий из смежных линий и дуг, – сегментов полилинии, объединенных таким образом, что начальная точка очередного графического элемента является конечной точкой предыдущего. Вызвать инструмент построения полилинии можно, применив два способа: нажав кнопку
раздела Document (Документ) палитры инструментов или используя кнопку
инструмента построения линий Line (Линия).
Общий алгоритм построения полилинии следующий.
1. Активизируйте инструмент построения полилинии одним из указанных выше способов.
2. Определите начальную точку полилинии, щелкнув кнопкой мыши на необходимом месте рабочего поля.
3. Выберите метод построения очередного сегмента. Если он тот же самый, что и для предыдущего сегмента, то пропустите этот пункт.
4. Выполните действия в соответствии с алгоритмом построения сегмента выбранным методом.
5. Повторяйте пп. 3-4 до тех пор, пока не будет построен последний сегмент полилинии.
6. Для завершения построения полилинии щелкните кнопкой мыши на конечной точке последнего сегмента еще раз. Если полилиния должна быть замкнутой, то щелкните на начальной точке полилинии.
Наиболее просто строится полилиния, состоящая только из прямо линейных сегментов, которая называется ломаной. Нужно просто последовательно щелкать кнопкой мыши на рабочем поле в тех местах, где должна находиться конечная точка очередного сегмента. Если полилиния должна включать криволинейный сегмент – дугу, то необходимо использовать один из методов построения дуги полилинии.
Выбрать метод построения сегмента полилинии можно, нажав од ну из кнопок палитры редактирования. Палитра редактирования появляется на экране при построении или редактировании сложного объекта и предоставляет пользователю набор инструментов для выбора необходимого метода. В частности, она появляется при указании начальной точки полилинии и содержит следующие пять кнопок (рис. 3.17).
Рис. 3.17. Палитра редактирования в режиме построения полилинии
– активна по умолчанию при вызове инструмента построения полилинии и означает, что в данный момент будет строиться прямолинейный сегмент. Ее также необходимо выбирать, если после построения дугообразного сегмента нужно построить прямолинейный.
– метод, вызываемый нажатием этой кнопки, позволяет построить дугу, которая является продолжением предыдущего сегмента полилинии. Перемещением указателя мыши задается положение конечной точки дуги (рис. 3.18), фиксируемое щелчком кнопки мыши.
ПРИМЕЧАНИЕ
В начале построения полилинии данная кнопка недоступна, так как невозможно определить направление дуги из-за отсутствия предыдущего сегмента.
– метод, вызываемый этой кнопкой, отличается от предыдущего тем, что пользователь задает направление дуги сам. Первым щелчком кнопкой мыши задается направление построения дуги, вторым – определяется ее конечная точка (рис. 3.19).
– метод, доступный с помощью этой кнопки, предназначен для построения дугообразного сегмента по трем точкам. Первой точкой, через которую будет проходить строящаяся дуга, является конечная точка предыдущего сегмента полилинии или ее начальная точка, если построение полилинии начинается с дуги. Вторая и третья точки указываются двумя последовательными щелчками кнопки мыши на рабочем поле (рис. 3.20). Последним щелчком фиксируется положение конечной точки дуги.
Рис. 3.18. Построение дуги, являющейся продолжением предыдущего сегмента
Рис. 3.19. Построение дугообразного сегмента с заданным направлением
Рис. 3.20. Построение дугообразного сегмента, проходящего через три точки
– метод предназначен для построения дуги, положение центра которой определяется первым щелчком кнопки мыши (рис. 3.21). Вторым щелчком указывается положение конечной точки дуги.
Рис. 3.21. Построение дуги с указанием ее центра
Построение кривых
Произвольные кривые можно построить с помощью инструмента Spline (Сплайн), кнопка которого
по умолчанию отсутствует в разделе Document (Документ) палитры инструментов. Чтобы активировать этот инструмент, нужно выполнить команду главного меню ArchiCAD Document ► Documenting Tools ► Spline (Документ ► Инструменты оформления ► Сплайн). В меню Document (Документ) находятся и все остальные рассматриваемые инструменты построения двумерных объектов. Информационная палитра с элементами управления этим инструментом имеет вид, показанный на рис. 3.22.
Рис. 3.22. Инструменты построения кривых
Существует два режима построения кривых: с разомкнутым и замкнутым контуром. Режимы устанавливаются кнопками
и
соответственно, расположенными на информационной палитре и в окне настройки параметров кривых по умолчанию.
ArchiCAD предоставляет три метода построения кривых: построение обычного сплайна, построение кривой Безье и черчение эскизной линии.
Используем метод построения обычного сплайна при установленном по умолчанию режиме разомкнутого контура, выполнив последовательность действий.
1. Нажмите кнопку
расположенную в разделе выбора методов построения.
2. Укажите начальную точку кривой, щелкнув кнопкой мыши на свободном месте рабочего поля, – в указанном месте появится маркер в виде косого креста.
3. Переместите указатель мыши в следующую точку и зафиксируйте ее щелчком кнопки мыши. Эта точка будет являться опорной точкой кривой. Опорные точки – это фиксированные точки, через которые проходит кривая.
4. Перемещая указатель мыши, подбирайте кривизну очередного сегмента и фиксируйте сегмент щелчком кнопкой мыши (рис. 3.23). Зафиксированная точка станет опорной для очередного сегмента.
Рис. 3.23. Построение обычного сплайна
5. Завершите построение кривой двойным щелчком кнопки мыши на конечной точке.
Остальные методы построения кривых можно освоить самостоятельно с помощью справочной системы. Отметим только, что построение замкнутого контура устанавливается нажатием кнопки
Построение кривой в этом режиме приведет к автоматическому соединению конечной точки кривой с ее начальной точкой. В различных методах рисования замыкание производится по-разному. В режиме отрисовки кривой Безье контур замыкается прямой линией после фиксации конечной точки. В остальных режимах контур замыкается рассчитанной по определенному алгоритму кривой, причем это делается динамически в процессе построения.
Штриховка
Вызвать инструмент создания штриховок можно, нажав кнопку Fill (Штриховка)
раздела Document (Документ) палитры инструментов. Палитра Info Box (Информационная палитра) в режиме построения штриховок отображает элементы управления настройкой параметров этого инструмента (рис. 3.24).
Рис. 3.24. Элементы управления настройкой параметров штриховки
Методы построения контуров штриховки не отличаются от соответствующих методов построения уже рассмотренных линии и полилинии. В области Geometry Method (Метод построения) информационной палитры содержатся следующие кнопки:
– построение области штриховки в виде замкнутого произвольного контура;
– построение прямоугольной области штриховки с указанием координат начальной и конечной точек диагонали прямоугольника;
– построение прямоугольной области штриховки по диагонали прямоугольника с поворотом на указанный угол.
Разница только в том, что при использовании инструмента Fill (Штриховка) область внутри построенного контура будет заштрихована. Рассмотрим подробнее настройку параметров штриховки, так как они в силу специфики штриховки отличаются от параметров рассмотренных выше графических примитивов.
Нажатие кнопки
открывает окно настройки параметров штриховки Fill Default Settings (Настройки параметров штриховки по умолчанию) (рис. 3.25).
Основные элементы управления настройкой параметров штриховки расположены в разделе General Settings (Общие настройки). В отличие от уже рассмотренных графических примитивов штриховка в общем случае состоит из трех объектов: контура, основного рисунка и фоновой области. В соответствии с этим для отрисовки каждого из этих параметров можно назначить собственное перо.
Рис. 3.25. Окно настройки параметров штриховки
Кнопка
предназначена для включения / отключения режима отрисовки границы вокруг области штриховки. При включении режима отрисовки становятся доступными кнопка выбора типа линии и элементы управления выбором пера для границы области штриховки, которые расположены справа от указанной кнопки. Соответствующая кнопка информационной палитры имеет несколько другой вид, чем обсуждаемая, а именно
(галочка находится в левом верхнем углу, а не в правом нижнем), но выполняет такую же функцию.
Под кнопкой выбора типа линии для границы области штриховки расположена кнопка выбора шаблона штриховки. Нажатие этой кнопки открывает список стандартных шаблонов штриховки (рис. 3.26), каждый из которых можно выбрать, щелкнув кнопкой мыши на нужном объекте списка.
Рис. 3.26. Список типов штриховки
Кроме обычных шаблонов штриховки можно выбрать сплошную заливку области, а также градиентные заливки – линейную и радиальную. Градиентная заливка – плавное изменение плотности закраски от начала до конца или от центра до краев области штриховки.
Справа от кнопки выбора типа штриховки расположены кнопки выбора перьев для элементов рисунка и фона штриховки.
В нижней части раздела General Settings (Общие настройки) расположен переключатель, определяющий угол наклона элементов шаблона штриховки, который можно установить в следующие три положения:
Link to Project Origin (Привязка к системе координат проекта) – положение элементов рисунка штриховки будет оставаться неизменным вне зависимости от изменения угла наклона области штриховки;
Link to Fill Origin (Привязка к системе координат штриховки) – угол наклона элементов штриховки определяется пользователем;
Use Distorted Fill (Использовать произвольный угол) – углы наклона и относительные размеры элементов штриховки определяются пользователем.
При построении штриховки с установкой переключателя в первое положение никаких дополнительных действий, кроме определения контура области штриховки, делать не нужно (рис. 3.27).
Рис. 3.27. Стандартная штриховка Block – Running Bond (Кирпич – кладка перевязью)
Если установить переключатель во второе положение, то построением контура области штриховки дело не закончится. Необходимо будет последовательными щелчками указать начальную и конечную точки вектора, определяющего угол наклона штриховки относительно горизонтальной оси (рис. 3.28, а). После указания конечной точки область будет заштрихована выбранным типом штриховки, сориентированным в соответствии с направлением вектора (рис. 3.28, б).
Рис. 3.28. Определение угла наклона шаблона штриховки
Установка переключателя в третье положение позволяет, во-первых, определить не просто угол наклона шаблона штриховки, но и взаимную ориентацию его элементов, а во-вторых, установить соотношение длин элементов штриховки. После определения контура система выведет запрос на ввод двух векторов, исходящих из одной точки (рис. 3.29, а). Каждый из векторов определяет угол наклона и относи тельный размер элементов штриховки, ориентированных в разных направлениях (рис. 3.29, б).
Рис. 3.29. Произвольное изменение параметров штриховки
Кроме того, установка для шаблона штриховки произвольного угла наклона его элементов делает вид объектов, показанных на разрезах и фасадах, а также скатов крыш на планах этажей более естественным.
Управление просмотром
ArchiCAD предоставляет пользователю мощные средства управления отображением проекта на экране. Сейчас рассмотрим только самые основные инструменты управления видом проекта, используемые при работе практически постоянно. Эти инструменты сгруппированы на панели, расположенной в нижней части экрана слева от горизонтальной линейки прокрутки изображения (рис. 3.30).
Рис. 3.30. Инструменты управления просмотром
Назначение этих кнопок достаточно прозрачно, поэтому опишем только некоторые из них.
Current Scale (Текущий масштаб) – кнопка установки масштаба чертежа. Нажатие этой кнопки открывает окно с запросом выбора из предлагаемого списка одного из стандартных масштабов или установки произвольного масштаба.
Zoom (Масштабирование) – кнопка индикации текущего увеличения изображения относительно установленного масштаба. При использовании элементов управления, изменяющих видимый размер изображения, текущее значение увеличения в процентах от реального масштаба отображается на данной кнопке. Нажатие кнопки устанавливает увеличение, соответствующее установленному масштабу, то есть 100 %.
Zoom Options (Выбор масштабирования) – кнопка быстрого выбора. При нажатии этой кнопки открывается меню со списком стандартных масштабов и сохраненных видов (рис. 3.31).
Scroll-Zoom (Изменение масштабирования) – кнопка управления динамическим изменением масштаба изображения. После нажатия этой кнопки и последующего щелчка на поле экрана движение указателя мыши будет изменять масштаб изображения.
Increase Zoom (Увеличение масштаба) – кнопка увеличения масштаба изображения выделенной области.
Reduce Zoom (Уменьшение масштаба) – кнопка уменьшения масштаба изображения выделенной области.
Рис. 3.31. Меню управления видами
Выполнение точных построений
До сих пор при построении объектов мы в основном использовали произвольное указание с помощью мыши таких их параметров, как начальная или конечная точка, радиус, угол наклона и т. п. Однако при построении реальных чертежей графические элементы должны иметь точные размеры и строго определенную ориентацию по отношению друг к другу. Поэтому любая система автоматизированного проектирования имеет в своем составе механизмы точного построения и привязки объектов. Естественно, есть они и в ArchiCAD.
В процессе построения объекта на экран выводится табло с указанием его текущих параметров, в частности при построении отрезков – расстояние от начальной точки и угол наклона отрезка относительно горизонтальной оси. Если нажать клавишу /, то вместо них появятся текущие значения координат указателя мыши относительно нулевой точки проекта. Координата, измеряемая по горизонтальной оси, обозначается буквой X, по вертикальной – буквой Y. Таким способом проще всего переключаться от декартовой (прямоугольной) системы координат (X, Y) к полярной (радиус, угол) и наоборот.
Просмотр текущих координат имеет только справочное значение. «Поймать» при построении объекта с помощью мыши точное значение его длины или угла наклона невозможно. Поэтому основное назначение табло – не просмотр координат указателя мыши, а их ввод и соответственно определение точного положения необходимой точки.
Чтобы ввести необходимое значение координат, нужно указать с клавиатуры один из символов: A, D, X или Y. На экране будет отображен полный вид табло (рис. 3.32) с активным полем для ввода данных.
Рис. 3.32. Вид информационного табло
Активность поля определяется введенным символом:
□ A – Angle (Угол) – ввод угла наклона;
□ D – Distance (Расстояние) – ввод расстояния от предыдущей точки;
□ X – X Coordinate – координата по оси X;
□ Y – Y Coordinate – координата по оси Y.
Переключаться между полями ввода можно также с помощью стрелок управления курсором, клавиши Tab или щелчком кнопкой мыши. Ввод данных завершается нажатием клавиши Enter.
По умолчанию в табло отображаются значения координат относительно последней введенной точки, но можно переключиться и на отображение / ввод абсолютных координат, отсчитываемых от начальной точки проекта. Для этого нужно щелкнуть кнопкой мыши на стрелочке кнопки
расположенной на панели инструментов Standard (Стандартная), и выбрать из открывшегося меню пункт Relative Coordinates in Tracker (Относительные координаты в табло). Повторный выбор этого действия вернет отображение относительных координат. Щелчком на самой кнопке можно включать / отключать отображение информационного табло на экране.
Из этой главы вы получили информацию об основных принципах создания двумерных графических объектов в программе ArchiCAD, научились использовать инструменты просмотра и механизмы точных построений, познакомились со средствами позиционирования курсора. Кроме того, у вас появились практические навыки определения свойств создаваемых объектов путем настройки их параметров.
Глава 4
Редактирование двумерных фигур
Неотъемлемой частью любой системы автоматизированного проектирования является набор средств для редактирования чертежей. Рассмотрим основные механизмы и инструменты редактирования, предоставляемые пользователю системой ArchiCAD.
Инструменты выделения объектов
Первое действие любого редактирования – определение объектов или групп объектов, которые необходимо отредактировать. Поэтому сначала поговорим о механизмах выделения объектов.
ПРИМЕЧАНИЕ
В тексте этой главы под объектом будет пониматься не только одиночный объект, но и совокупность объектов – группа, если они выделены, что бы их можно было редактировать.
Если вы находитесь в режиме построения объектов, то для включения режима выделения нужно нажать клавишу Shift. Признаком включения этого режима будет изменение формы указателя мыши на
Установка указателя мыши на объект (рис. 4.1, а) приведет к изменению вида объекта – составляющие его элементы будут отображены толстой синей линией (рис. 4.1, б). Щелчок кнопкой мыши выделит объект – его элементы отобразятся толстой зеленой линией, а характеристические точки будут выделены черным цветом (рис. 4.1, в).
ПРИМЕЧАНИЕ
Цветовые атрибуты объекта при его выделении настраиваются с помощью элементов управления, расположенных в окне Selection and Element Information (Выбор и информация об элементе), открываемом командой Options ► Work Environment ► Selection and Element Information (Параметры ► Рабочая среда ► Выбор и информация об элементе).
Рис. 4.1. Вид объекта при выделении
Для выделения нескольких объектов достаточно просто щелкнуть на них кнопкой мыши, удерживая нажатой клавишу Shift. Чтобы отменить выделение объекта, нужно щелкнуть на нем кнопкой мыши, удерживая нажатой клавишу Shift. Для снятия выделения со всех объектов следует щелкнуть кнопкой мыши на свободном месте рабочего поля без нажатия каких-либо клавиш.
Второй способ активизации режима выделения – использование специальных инструментов, расположенных в разделе Select (Выбор) палитры инструментов.
Первый из этих инструментов активизируется нажатием кнопки Arrow (Стрелка)
Элементы управления этого инструмента отобразятся на палитре Info Box (Информационная панель) (рис. 4.2).
Рис. 4.2. Инструменты выбора объектов
С помощью этих элементов становится доступным еще один способ выделения нескольких объектов. Он заключается в построении контура, охватывающего необходимые объекты. Существуют три возможных метода построения контура: в виде ломаной, в виде прямоугольника и в виде повернутого прямоугольника. Выбрать необходимый метод можно с помощью одной из кнопок, вызываемых нажатием второй кнопки палитры (рис. 4.3). Контур строится так же, как и соответствующие графические примитивы.
При построении контура включить объекты в состав выделенных можно одним из двух способов, каждый из которых активируется соответствующей кнопкой, вызываемой нажатием первой кнопки палитры (рис. 4.4).
При первом способе граница контура отрисовывается точечной линией. Все объекты, которые будут полностью охвачены таким контуром или хотя бы пересекутся его границей, станут выделенными.
Рис. 4.3. Определение способа построения контура выделения
Рис. 4.4. Выбор способа включения объектов в состав выбранных
При втором способе граница контура отрисовывается штрихпунктирной линией, а выделенными будут только те объекты, которые полностью попадут внутрь контура.
Кроме прямого указания или охватывающего контура для выделения объектов можно использовать и другие методы. Например, при нахождении в режиме выделения можно выделить все объекты в окне нажатием комбинации клавиш Ctrl+A.
Если система находится в режиме построения, то при нажатии комбинации клавиш Ctrl+A выделятся только объекты, имеющие тип актив ного инструмента, причем переключение на другой инструмент не отменит выделение уже выбранных объектов. Это позволит последовательным переключением инструментов и нажатием комбинации клавиш Ctrl+A выделять группы объектов, например, выбрать окружности, дуги и полилинии.
Кнопка
служит для вызова инструмента быстрого выбора.
Второй инструмент раздела Select (Выбор) палитры инструментов вызывается нажатием кнопки Marquee (Область выделения)
Он также предназначен для выделения объектов с помощью построения контура, но имеет следующие отличия.
□ Границы контура в процессе его построения обозначаются сплошной линией, а по завершении – движущимся пунктиром («бегущие муравьи»).
□ При построении области выделения с помощью этого инструмента объекты визуально не выделяются.
□ Объекты считаются выбранными, только если внутрь области выделения попадают их характеристические точки.
□ По завершении выделения область выделения не удаляется и готова для выполнения следующего действия.
□ Область выделения можно перемещать, изменяя таким образом набор выбранных элементов без повторного построения контура. Для перемещения области выделения нужно щелкнуть кнопкой мыши на пустом месте внутри области. Указатель мыши примет вид
после чего область выделения можно перетащить в другое место.
□ Инструментом Marquee (Область выделения) можно выделять объекты, находящиеся не только на рабочем этаже, но и на всех этажах здания. Для этого необходимо нажать первую кнопку информационной палитры, а затем кнопку с двойным контуром (рис. 4.5).
Рис. 4.5. Выбор глубины действия области выделения
Комбинацией клавиш Ctrl+F можно вызвать окно выбора объектов по их свойствам Find & Select (Поиск и выбор) (рис. 4.6).
Рис. 4.6. Выбор объектов по их свойствам
Раскрывающийся список Find Elements (Найти элементы) предназначен для выбора конкретного типа объекта, например линии, окружности, дуги, стены, балки и т. д.
Если нужно выделить не все элементы данного типа, а только те из них, которые имеют определенные параметры, то для этого необходимо использовать соответствующие элементы управления рассматриваемого окна. Каждое нажатие кнопки More Choices (Добавить параметр) добавляет очередной параметр отбора к уже имеющимся. Например, на рис. 4.6 активен только выбор по номеру пера. Однако можно выбирать объекты по тринадцати параметрам: цвету и типу линии, этажу, слою, материалу и т. д. Порядок добавления параметров отбора кнопкой More Choices (Добавить параметр) определяется списком, который активизируется нажатием кнопки одного из добавленных параметров (рис. 4.7).
Сформировать произвольную комбинацию параметров отбора можно, добавив необходимое количество параметров отбора и выбрав для каждого из них необходимый тип из списка соответствующих параметров.
Рис. 4.7. Список параметров отбора
Справа от каждого параметра отображаются его свойства. Устанавливая конкретное значение или диапазон значений для свойств данного параметра, пользователь определяет критерии отбора объектов.
Рассмотрим пример. Предположим, необходимо выделить для дальнейшего редактирования окружности, отрисованные пунктирной линией и находящиеся на определенном слое. Для этого нужно выполнить следующие действия.
1. Нажмите комбинацию клавиш Ctrl+F – откроется окно Find & Select (Поиск и выбор) (см. рис. 4.6).
2. Откройте список Find Elements (Найти элементы) и выберите из него объект Arc / Circle (Дуга / Окружность).
3. Нажмите кнопку More Choices (Добавить параметр) – между кнопками Fewer Choices (Удалить параметр) и More Choices (Добавить параметр) появится кнопка Pencolor (Цвет пера), которая идет первой в списке параметров отбора.
ПРИМЕЧАНИЕ
Поскольку отбор по этому параметру не нужен, необходимо заменить его одним из заданных.
4. Нажмите кнопку Pencolor (Цвет пера) – откроется список параметров отбора.
5. Из открывшегося списка выберите параметр Line Type (Тип линии). Кнопка Pencolor (Цвет пера) заменится кнопкой Line Type (Тип линии), а справа от этой кнопки появится кнопка выбора типа линии.
6. Нажмите кнопку выбора типа линии – откроется список доступных типов линий.
7. Выберите пунктирную линию, щелкнув на элементе списка Dashed (Пунктирная).
8. Нажмите кнопку More Choices (Добавить параметр) – под кнопкой Line Type (Тип линии) снова появится кнопка Pencolor (Цвет пера).
9. Нажмите кнопку Pencolor (Цвет пера) – откроется список параметров отбора, из которого выберите параметр Layer (Слой). Кнопка Pencolor (Цвет пера) заменится кнопкой Layer (Слой), а справа от этой кнопки появится кнопка выбора слоя. Подробно работа со слоями будет рассмотрена в главе 7.
10. Нажмите кнопку выбора слоя, чтобы открыть список слоев и выбрать из него необходимый.
Установив все необходимые параметры отбора, нужно активизировать их, нажав кнопку
Все элементы, соответствующие установленным параметрам отбора, будут добавлены к совокупности уже выделенных объектов, что визуально отражается на рабочем поле. Объекты выделятся в соответствии с установленными цветовыми атрибутами. Нажатие кнопки
удаляет объекты с установленными критериями из набора выделенных объектов, отменяя выделение цветом.
Таким образом, последовательно устанавливая необходимые параметры отбора и добавляя или удаляя объекты, соответствующие этим параметрам, можно сформировать необходимую совокупность объектов для выполнения над ними какого-либо группового действия.
Убрать ненужный параметр отбора из списка параметров отбора можно, нажав кнопку этого параметра и выбрав команду Remove Criterion (Удалить параметр) из открывающегося списка параметров отбора. Кнопка Fewer Choices (Удалить параметр) удаляет последний из имеющихся параметров отбора.
При использовании кнопки Pick Up Settings (Захват параметров)
становится доступным механизм передачи параметров. Кнопка Copy Settings (Копирование параметров)
становится доступной, если на рабочем поле уже выделен хотя бы один объект. При нажатии данной кнопки свойства последнего из выделенных объектов передаются в качестве параметров отбора текущего элемента.
Сформированную совокупность выделенных объектов можно сохранить для последующего использования. Окно с запросом имени для сохраняемой совокупности объектов вызывается командой Save (Сохранить) из меню, появляющегося при нажатии кнопки
расположенной справа от открывающегося списка типов объектов. Загружается сохраненная совокупность объектов командой Load (Загрузить), вызываемой из того же меню.
Группирование элементов
Если необходимо постоянно работать с какой-то совокупностью выделенных объектов, то можно объединить их с помощью механизма группирования. Для этого нужно выделить необходимые объекты и нажать комбинацию клавиш Ctrl+G. Существует и другой способ – выполнить команду основного меню программы ArchiCAD Edit ► Grouping ► Group (Редактор ► Группирование ► Сгруппировать).
После этого действия совокупность сгруппированных объектов с точки зрения редактирования становится одним целым. Она выделяется щелчком кнопкой мыши на любом из входящих в нее составляющих элементов, и действие команды редактирования применяется сразу ко всем входящим в группу объектам.
Для разгруппирования объектов используется команда Edit ► Grouping ► Ungroup (Редактор ► Группирование ► Разгруппировать), а также комбинация клавиш Ctrl+Shift+G.
Если требуется, не выполняя разгруппирования, поработать с одним из объектов, входящих в состав группы, например изменить его положение относительно других входящих в группу объектов или значение какого-то его параметра, то в этом случае необходимо использовать команду главного меню ArchiCAD Edit ► Grouping ► Suspend Groups (Редактор ► Группирование ► Временно разгруппировать) или кнопку
расположенную на панели инструментов Standard (Стандартная). Соответствующая комбинация клавиш для этого действия – Alt+G. При разгруппировании все действия по редактированию конкретного объекта влияют только на него, но он тем не менее остается в составе группы.
Объектная привязка
Прежде чем рассматривать команды редактирования, обратим внимание на абсолютно необходимый для квалифицированной работы инструмент – объектную привязку. Его назначение – привязка характеристических точек перемещаемого объекта к характеристическим точкам уже существующих. Активизируется этот инструмент нажатием кнопки Element Snap (Объектная привязка)
расположенной на панели инструментов Standard (Стандартная), командой Options ► Element Snap (Параметры ► Объектная привязка) или нажатием клавиши Е.
После активизации этого метода каждая характеристическая точка выделенного объекта помечается специальным маркером, имеющим вид квадрата. При попадании маркированной точки на характеристическую точку другого объекта или его границу, точку пересечения объектов, направляющую и т. п. маркер изменяет свой вид: увеличивается размер маркера и толщина его контура. Кроме того, при приближении маркированной точки к какому-либо объекту на расстояние, не большее размера маркера, маркированный объект «притягивается» своей ближайшей маркированной точкой к границе, узлу, направляющей и т. п. Это позволяет быстро и точно «привязать» объекты друг к другу требуемым образом.
Пример выполнения редактирования с использованием метода объектной привязки будет приведен ниже при рассмотрении действия перетаскивания.
Методы редактирования объектов
Под редактированием объекта будем понимать изменение его размеров, формы, а также расположения относительно других объектов. Рассмотрим несколько основных методов редактирования двумерных объектов.
Редактирование без изменения формы
К методам редактирования объекта без изменения его формы относятся перемещение, поворот, копирование, зеркальное отображение и размножение. Команды для выполнения этих действий собраны в меню, вызываемом из главного меню программы ArchiCAD командой Edit ► Move (Редактор ► Переместить).
В данное меню входят следующие команды, вызываемые также соответствующей комбинацией клавиш:
□ Drag (Перетащить) – Ctrl+D;
□ Rotate (Повернуть) – Ctrl+E;
□ Mirror (Зеркально отобразить) – Ctrl+M;
□ Elevate (Изменить возвышение) – Ctrl+9;
□ Drag а Сору (Копировать) – Ctrl+Shift+D;
□ Rotate a Copy (Повернуть копию) – Ctrl+Shift+E;
□ Mirror a Copy (Зеркально отобразить копию) – Ctrl+Shift+M;
□ Drag Multiple Copy (Размножить);
□ Rotate Multiple Copy (Размножить поворотом);
□ Multiply (Тиражировать) – Ctrl+U.
Первые четыре команды применяются к выделенным объектам, следующие три – к автоматически создаваемым копиям объектов, а последние повторяют действие до тех пор, пока пользователь не отменит его.
Перетаскивание
Чтобы перетащить объект, необходимо выполнить следующие действия.
1. Выделить объект с помощью любого способа выделения.
2. Выполнить команду главного меню ArchiCAD Edit ► Move ► Drag (Редактор ► Переместить ► Перетащить) или нажать комбинацию клавиш Ctrl+D.
3. Указать начальную и конечную точки направления перемещения двумя последовательными щелчками кнопки мыши на любых точках рабочего поля. Объект будет перемещен в соответствии с определенным направлением (рис. 4.8).
Рис. 4.8. Перетаскивание объекта
ПРИМЕЧАНИЕ
Если при выполнении действия после указания начальной точки нажать клавишу Ctrl, то будет выполняться копирование объекта.
Ознакомившись с принципом выполнения перетаскивания, рассмотрим простой пример, иллюстрирующий использование объектной привязки и направляющих при перемещении объектов.
Используя необходимые инструменты, постройте расположенные рядом окружность и линию (рис. 4.9, а).
Необходимо переместить линию так, чтобы она исходила из центра окружности. Задача осложняется тем, что центр окружности невидим, поэтому нужно выполнить следующие действия.
1. Активировать режим объектной привязки.
2. Выделить перемещаемую линию любым из способов выделения.
3. Выполнить команду перетаскивания главного меню Edit ► Move ► Drag (Редактор ► Переместить ► Перетащить).
4. Щелкнуть кнопкой мыши на линии и переместить указатель мыши к окружности так, чтобы он принял форму
5. Задержать указатель мыши в этом положении до тех пор, пока на окружности не появится пунктирная направляющая оранжевого цвета (рис. 4.9, б). Центр окружности отметится крестиком.
а
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Рис. 4.9. Определение центра окружности с использованием направляющей
6. Продолжать перемещать линию таким образом, чтобы ее конец попал в центр окружности. Когда это произойдет, маркер, находящийся на этом конце линии, увеличится в размерах, а указатель мыши примет формуй (рис. 4.10, а). Это означает, что произошла точная привязка конца линии к центру окружности.
7. Щелкнуть кнопкой мыши – задача решена (рис. 4.10, б).
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Рис. 4.10. Использование объектной привязки
ПРИМЕЧАНИЕ
Использование направляющих необязательно при выполнении действий с активной объектной привязкой. Построение произойдет и без визуальной пометки центра окружности.
Дальнейшие действия редактирования аналогичны вышеописанным, можно освоить их самостоятельно, прибегнув к справочной системе программы.
Блокирование объектов
В заключение главы, посвященной редактированию объектов, упомянем о механизме, позволяющем избежать случайного изменения объектов или их свойств. В ArchiCAD есть способ защитить необходимые объекты от редактирования. Для этого следует выделить их и выполнить команду Edit ► Locking ► Lock (Редактор ► Блокирование ► Блокировать).
Объекты, заблокированные этим способом, нельзя редактировать: изменять их форму, местоположение, параметры и т. п. Однако заблокированные объекты можно, например, копировать, причем копии не будут заблокированными. Можно также копировать параметры заблокированных объектов и передавать их другим.
Если понадобится отредактировать заблокированные объекты, то можно разблокировать их командой главного меню ArchiCAD Edit ► Locking ► Unlock (Редактор ► Блокирование ► Разблокировать).
Кнопки выполнения этих действий, имеющие вид замкнутого и разомкнутого замка соответственно, находятся на панели Arrange Elements (Упорядочивание элементов).
В этой главе представлена информация об основных принципах и инструментах редактирования двумерных графических объектов в программе ArchiCAD. Были рассмотрены способы выделения объектов для последующего редактирования, команды изменения формы и относительного расположения графических примитивов.
Вы научились использовать методы привязки и группирования объектов, познакомились с механизмами передачи параметров и способом защиты объектов от непреднамеренного изменения.
Глава 5
Создание специализированных конструктивных элементов
В этой главе содержатся сведения, являющиеся основой для понимания принципов разработки проектов в среде ArchiCAD. Здесь будут рассмотрены методы создания конструктивно-планировочной структуры архитектурного сооружения, включая поэтажное планирование, построение и редактирование основных конструктивных элементов, а также настройку их параметров.
Настройка параметров этажей
При разработке проектов в среде ArchiCAD пользователь работает с этажом. Под этажом понимается пространство, ограниченное определенной высотой, в котором размещаются строительные элементы, детали конструкций, объекты интерьера и т. п. ArchiCAD позволяет переключаться между этажами проекта, копировать и переносить объекты с этажа на этаж, видеть одновременно несколько этажей, чтобы определить относительное размещение объектов, то есть дает возможность полноценной работы проектировщика.
Разработка проекта должна начинаться с определения количества и взаимного расположения этажей здания. Окно настройки параметров этажей Story Settings (Настройки этажа) (рис. 5.1) вызывается командой главного меню Design ► Story Settings (Проектирование ► Параметры этажа) или нажатием комбинации клавиш Ctrl+7.
В верхней части данного окна расположен список этажей. В соответствии со стандартами проектирования, принятыми на Западе, первый этаж называется Ground Floor (Наземный этаж) и имеет номер 0, второй имеет номер 1, третий – 2 и т. д. Номера этажей отображаются в поле No. (Номер), расположенном в левой части списка этажей. Активизировать необходимый элемент списка этажей можно щелчком кнопки мыши на любом из полей и редактировать находящуюся там информацию.
Рис. 5.1. Настройка параметров этажей
В поле Name (Наименование) вводится имя этажа. Можно давать каждому этажу произвольные имена, обеспечивая удобство работы с ними.
В поле Elevation (Возвышение) указывается высота нижней точки этажа относительно нулевого уровня, за который по умолчанию принимается уровень пола этажа, имеющего номер 0.
Поле Height to Next (Высота этажа) определяет разность возвышений смежных этажей, то есть фактически высоту этажа.
Поля Elevation (Возвышение) и Height to Next (Высота этажа) взаимосвязаны, поэтому при вводе информации в одно из этих полей значение другого пересчитывается автоматически. Установка флажка в этом поле обеспечивает автоматическую отрисовку на разрезах линий уровня помеченного этажа.
Кнопки Insert Above (Поместить над), Insert Below (Поместить под) предназначены для добавления этажей, а кнопка Delete Story (Удалить этаж) – для удаления. Новый этаж добавляется относительно текущего этажа, выделенного в списке.
Для выполнения групповых действий над объектами, расположенными на этажах, предназначены элементы управления Edit Elements of Selected Story (Редактирование элементов выбранного этажа), расположенные в нижней области окна. Эти элементы соответствуют всем типам объектов, над которыми можно выполнять групповое действие. Включается объект в группу установкой флажка справа от названия объекта.
Нажатие кнопки Cut All (Вырезать все) помещает в окно сценария групповых действий Event List (Список событий) команду Cut from (Вырезать из). Действие этой команды заключается в удалении объектов выбранных типов с этажа, который был активным в момент нажатия кнопки Cut All (Вырезать все), и помещении их в буфер обмена.
Кнопка Copy All (Копировать все) помещает в окно сценария групповых действий Event List (Список событий) команду Copy from (Копировать из). Она отличается от предыдущей тем, что выбранные объекты не удаляются с этажа, и в буфер помещаются их копии.
Кнопка Paste Selected Types (Вставить выбранные типы объектов) расположена под списком типов объектов и недоступна при пустом буфере обмена. Использование данной кнопки помещает команду Paste to (Вставить на) в окно сценария групповых операций Event List (Список событий). Команда помещает объекты, находящиеся в буфере обмена, на текущий этаж.
Нажатие кнопки Delete All (Удалить все) помещает в окно сценария групповых действий Event List (Список событий) команду Delete from (Удалить с), которая удаляет объекты выбранного типа с этажа, бывшего активным в момент использования данной кнопки.
ВНИМАНИЕ
Будьте осторожны! Действия, выполняемые кнопками Delete All (Удалить все) и Cut All (Вырезать все), невозможно отменить. Перед выполнением этих действий выводится предупреждающее сообщение: Deleting Stories and deleting / cutting from Story content are not undoable! (Действия удаления этажей и удаления / вырезания их объектов отменить невозможно!).
Кнопка OK закрывает окно Story Settings (Настройки этажа) с активизацией всех установленных настроек, в том числе с последовательным выполнением команд, помещенных в окно сценария групповых действий Event List (Список событий).
Таким образом, работу по проектированию здания можно описать следующими действиями.
1. Открывается окно Story Settings (Настройки этажа).
2. На один из имеющихся в проекте этажей (предположим, это этаж с номером 0) разработчик помещает необходимые объекты, например стены, окна, двери, колонны, предметы интерьера и т. п.
3. При необходимости разработчик редактирует настройки этажа с присвоением ему необходимого имени, а также с установкой возвышения и высоты. На этом подготовительная работа завершена – теперь быстрое построение.
4. С помощью кнопок Insert Above (Поместить над) и Insert Below (Поместить под) создается необходимое количество этажей с установкой их параметров.
5. Активизируется этаж с установленными на предварительном этапе объектами (в нашем случае – с номером 0).
6. Устанавливаются флажки напротив типов объектов, которые необходимо скопировать, или снимаются с тех, которые копировать не нужно.
7. Нажимается кнопка Copy All (Скопировать все) – в окне сценария групповых действий Event List (Список событий) появляется строка Copy from 0 (Скопировать с первого этажа), а под списком типов объектов становится доступной кнопка Paste Selected Types (Вставить выбранные типы объектов).
8. Активизируется очередной этаж.
9. Нажимается кнопка Paste Selected Types (Вставить выбранные типы объектов) – в списке сценария групповых действий появляется строка Paste to n (Вставить на n-й этаж).
10. Последовательно выполняются пункты 2–6 до тех пор, пока не будет обработан последний этаж.
ПРИМЕЧАНИЕ
Если на все этажи здания нужно поместить одни и те же объекты, то выполняются только пункты 5 и 6.
11. Нажатие кнопки OK приведет к последовательному выполнению действий в соответствии с их расположением в списке действий, то есть в здании появится необходимое количество этажей с расположенными на них объектами.
Конечно, разработка проекта не сводится только к созданию этажей и копированию на них объектов, однако понять, сколько времени разработчику может сэкономить рассмотренный механизм копирования, можно уже из приведенного примера.
Изучим методы создания объектов и, поскольку основу этажа составляют стены, начнем рассмотрение с построения и редактирования стен. Инструменты создания объектов расположены в разделе Design (Проектирование) палитры ToolBox (Палитра инструментов).
Для примера рассмотрим процедуру построения стен, перекрытий и крыши – основных компонентов любого здания.
Формирование стен этажа
Для построения стен используется инструмент Wall (Стена), активизируемый нажатием кнопки
После выбора этого инструмента на информационной палитре появятся элементы управления, предназначенные для настройки параметров стены (рис. 5.2).
Рис. 5.2. Информационная палитра в режиме построения стен
Рассмотрим эти элементы в окне настройки параметров стены по умолчанию, где они расположены более компактно.
Настройка параметров стен по умолчанию
Окно установки параметров стены Wall Default Settings (Настройки параметров стен по умолчанию) (рис. 5.3) вызывается нажатием кнопки
– первой кнопки информационной палитры.
Рассмотрим основные разделы данного окна, в которых расположены элементы управления настройками параметров стен.
ПРИМЕЧАНИЕ
Чтобы «раскрыть» раздел, то есть отобразить входящие в него элементы управления, необходимо щелкнуть кнопкой мыши на заголовке раздела. Аналогичным образом раздел закрывается.
Элементы управления, с помощью которых определяется положение стены, ее форма и размеры, находятся в разделе Geometry and Positioning (Форма и расположение).
Рис. 5.3. Окно установки параметров стен
Первые три поля данного раздела предназначены для установки высоты стены, возвышения основания стены относительно уровня текущего этажа и относительно одного из базовых уровней проекта. По умолчанию за базовый уровень принят уровень первого этажа. При изменении значения одного из двух последних полей будет меняться и другое, так как они взаимосвязаны. Если за базовый уровень принят Project Zero (Нулевой уровень проекта), то для первого этажа эти значения будут совпадать.
Форма стены определяется с помощью кнопок, расположенных в правой части раздела. Первый ряд кнопок позволяет указать один из трех вариантов расположения базовой линии стены, по которой будут сопрягаться смежные стены: по оси стены или со смещением к одной или другой стороне. При выборе базовой линии со смещением в текстовом поле, расположенном справа от кнопок, можно указать значение смещения базовой линии от края стены.
Следующий ряд кнопок используется для выбора формы стены. Кнопкой
выбирается стена с постоянной толщиной профиля, кнопка
предназначена для выбора стены с равномерно изменяющейся толщиной, а кнопка
– для стены произвольной формы. Размеры геометрических элементов стены вводятся в поля, расположенные справа от кнопок выбора формы стены. Количество этих полей и вводимые параметры зависят от выбранной формы стены. Для стены с постоянным сечением доступно одно поле, в котором вводится ее толщина. Для стены с равно мерно изменяющейся толщиной отображаются два поля, в которые заносится толщина стены в начальной и конечной точках.
Для выбора профиля стены предназначен последний ряд кнопок раздела:
– назначает стене прямоугольный профиль;
– позволяет построить стену с наклоном, при выборе этого варианта становится доступным поле для ввода угла наклона стены, расположенное справа от описываемого ряда кнопок;
– используется для построения стены с трапециевидным профилем, для указания углов наклона каждой из сторон используются два текстовых поля, появляющихся справа;
– определяет профиль стены, имеющей произвольное сечение или неоднородной по составу.
Кнопки раздела Model (Модель) (рис. 5.4) окна Wall Default Settings (Настройки параметров стен по умолчанию) предназначены для выбора материала облицовки внутренней, торцевой и наружной поверхностей стены.
Рис. 5.4. Кнопки выбора материала облицовки стены
С помощью любой из кнопок открывается окно выбора материалов для объемного отображения объектов, в том числе стен (рис. 5.5).
Если нажата одна из кнопок с изображением звеньев цепи, расположенная справа от каждой из кнопок выбора материала, то материал, выбранный для любой из поверхностей, становится общим для всех поверхностей стены.
Рис. 5.5. Библиотека материалов для объемного изображения объекта
Построение стен
Геометрические методы построения стен выбираются с помощью следующих кнопок, расположенных в соответствующем разделе информационной палитры (см. рис. 5.2):
– построение прямых и криволинейных стен с постоянным сечением;
– построение стен с основанием в виде дуги или окружности;
– построение стен с переменным сечением;
– построение стен с основанием произвольной формы (полигональных стен).
Различные методы построения прямых и криволинейных стен с постоянным сечением можно выбрать из панели (рис. 5.6), которая открывается кнопкой
Нажатие одной из кнопок данной панели активизирует необходимый метод.
Кнопкой
выбирается метод построения прямолинейных стен.
Метод построения сложных контуров стен с постоянным сечением, состоящих из последовательно соединенных прямолинейных и дуговых сегментов, активизируется кнопкой
Кнопки
и
соответствуют методам построения замкнутых прямоугольных контуров, ориентированных по координатной сетке и с произвольным углом поворота относительно ее.
Три метода построения стен с основанием в виде дуг и окружностей связаны с кнопками, появляющимися при нажатии кнопки
(рис. 5.7).
Рис. 5.6. Методы построения стен с произвольным сечением
Рис. 5.7. Методы построения стен с основанием в виде дуг и окружностей
Кнопка
предназначена для выбора метода построения стены по центру и радиусу.
Для построения стены по трем точкам необходимо использовать метод, выбираемый с помощью кнопки
а кнопка
связана с методом построения дуги по двум касательным и точке.
Не будем подробно рассматривать процесс построения стен, поскольку он полностью идентичен процессу построения двумерных объектов: линий, окружностей, дуг и полилиний.
При построении прямолинейных стен с переменным сечением следует установить разную ширину стены для ее концов, иначе получится обычная прямая стена.
Необходимо различать методы построения полигональных стен и стен в виде полилинии. При построении стены в виде полилинии она охватывает произвольно определенный контур (рис. 5.8).
Полигональная стена занимает всю площадь контура (рис. 5.9).
Изменение геометрии стен
Стены на плане подобны двумерным объектам, поэтому их можно редактировать, то есть перемещать, копировать, поворачивать, зеркально отображать и т. п. Однако в силу определенной специфики стен для них существуют и особые действия редактирования, неприменимые для двумерных объектов. Эти отличия касаются, во-первых, изменения положения и размеров стен по третьей координате – высоте, которая не имеет смысла для двумерных объектов, расположенных на плоскости уровня этажа, а во-вторых, двумерные объекты не имеют толщины.
Рис. 5.8. Построение стены в виде полилинии
Рис. 5.9. Полигональная стена
В четвертой главе были рассмотрены способы редактирования путем вызова команд из меню Edit (Редактор). Однако существует более эффективный метод работы с объектами – использование палитры редактирования (см. разд. «Построение полилиний» гл. 3). Именно его мы и будем применять в дальнейшем.
При редактировании объектов эта палитра появляется на экране при щелчке кнопкой мыши на выделенном объекте. Набор кнопок, расположенных на палитре редактирования, зависит от конкретной ситуации, при которой она была вызвана: типа выделенного объекта, на котором был произведен щелчок; места на объекте, где находился при щелчке указатель мыши; состояния выделенного объекта; режима редактирования и т. п.
Постройте прямую стену с постоянным сечением. Выделите ее и щелкните кнопкой мыши на базовой линии стены – появится палитра редактирования с набором действий, применимых к выделенному ребру стены (рис. 5.10).
Рис. 5.10. Палитра редактирования прямой стены с постоянным сечением
Данная палитра включает в себя десять кнопок, определяющих действия редактирования, которые могут быть применены к данной стене. Рассмотрим самые важные из этих действий, вызываемых следующими кнопками, подробнее.
– Drag (Перемещение) – применяется для перемещения стены на другое место. После нажатия данной кнопки необходимо указать точку перемещения. Стена изменит свое положение в соответствии с указанной точкой (рис. 5.11).
Рис. 5.11. Перемещение стены
В новое положение перемещенная стена встанет той точкой, на которой находился указатель мыши при щелчке на базовой линии стены. Если нужно установить в определенную точку, например конец или середину стены, то щелкать при вызове палитры редактирования нужно именно на этих точках или, что настоятельно рекомендуется, использовать метод объектной привязки (см. гл. 4).
ПРИМЕЧАНИЕ
Как и для плоских объектов, перемещение при нажатой клавише Ctrl действует как копирование.
– Rotate (Поворот) – предназначена для поворота выделенного объекта. После выбора действия первым щелчком кнопки мыши определяется точка, относительно которой будет повернут объект, вторым щелчком фиксируется начальная точка дуги поворота и третьим – конечная точка дуги поворота (рис. 5.12).
Рис. 5.12. Поворот стены
– Mirror (Зеркальное отражение) – после выбора действия щелчками кнопки мыши указываются начальная и конечная точки линии, относительно которой должен быть отражен объект (рис. 5.13).
Рис. 5.13. Действие зеркального отражения
Мы рассмотрели инструменты редактирования прямых стен с постоянным сечением. Как было показано, некоторые из действий редактирования превращают прямые стены в трапециевидные (полигональные), которые имеют специфичные функции редактирования. Рассмотрим для примера одну из них.
– Offset all edges (Растяжение / сжатие контура) – действие пропорционального изменения размеров выделенного контура. Нажав данную кнопку, необходимо указать точку, через которую будет проходить новый контур, стороны которого параллельны соответствующим сторонам выбранного (рис. 5.14). Для сжатия контура указываемая точка должна находиться внутри контура.
Рис. 5.14. Растяжение / сжатие контура
Формирование перекрытий
Под перекрытием в ArchiCAD подразумевается плоский элемент, подобный полигональной стене. Подробно рассматривать перекрытие нецелесообразно, поскольку практически все элементы управления его настройками и способы построения и редактирования уже известны по другим объектам.
Для построения перекрытий используется инструмент Slab (Перекрытие), вызываемый кнопкой
палитры инструментов.
Материал для объемного отображения перекрытия можно выбрать отдельно для верхней, нижней и торцевой граней в разделе Model (Модель) окна Slab Default Settings (Настройки параметров перекрытия по умолчанию), которое вызывается кнопкой
информационной палитры.
Для построения перекрытия необходимо определить его контур, используя один из методов, который выбирается нажатием соответствующей кнопки информационной палитры. Имеется три метода: построение прямоугольного контура, прямоугольного контура с поворотом и произвольного контура. Все эти методы рассматривались ранее при построении линий, полилиний и стен.
Формирование крыш
Самый сложный объект здания – крыша, так как она может иметь разнообразные формы, а ее конструкционные элементы – скаты – расположены в пространстве в разных плоскостях.
Скаты могут быть прямоугольной или многоугольной формы. Положение скатов определяется двумя параметрами: базовой линией, располагающейся на нижней грани ската и параллельной плоскости этажа, и уклоном – углом наклона плоскости ската к горизонтальной плоскости. Направление уклона ската крыши на плане этажа определяется по риске, расположенной на базовой линии ската. Она направлена в сторону возвышения ската.
Для построения крыш в программе используется инструмент Roof (Крыша), кнопка вызова которого
находится в разделе Design (Проектирование) палитры инструментов. Нажатие этой кнопки отображает элементы управления инструмента построения крыш на информационной палитре (рис. 5.15).
Кнопка
информационной палитры открывает окно Roof Default Settings (Настройки параметров крыш по умолчанию) (рис. 5.16).
Рис. 5.15. Информационная панель в режиме построения крыш
ПРИМЕЧАНИЕ
Поскольку крыша является составным объектом, то настройки параметров будут относиться к строящемуся или редактируемому скату (скатам), а не ко всей крыше в целом.
Настройка параметров крыш
В разделе Geometry and Positioning (Форма и расположение) отсутствует поле для ввода высоты объекта, поскольку высота ската крыши будет определяться его уклоном. Уклон ската устанавливается в поле Roof Slant Angle (Угол уклона ската), расположенном в правой области раздела.
В расположенных ниже полях устанавливается толщина ската, которая может быть измерена как толщина поперечного или вертикального среза. Значения этих величин при установленном уклоне взаимосвязаны.
Рис. 5.16. Окно настройки параметров крыш
ПРИМЕЧАНИЕ
Два последних поля недоступны для изменения, если в качестве профиля ската выбран многослойный профиль, имеющий заданную толщину.
Переключатель, расположенный в правой части раздела Model (Модель) данного окна, предназначен для установки формы подрезки торца ската. Он имеет три положения: подрезка, перпендикулярная плоскости ската, подрезка по вертикальной плоскости и выборочный, параметры которого устанавливаются в окне Roof Edge Angle (Угол подрезки ската) (рис. 5.17). Данное окно открывается нажатием кнопки
палитры редактирования ската.
Рис. 5.17. Окно настройки подрезки ската
В данном окне, кроме трех вышеназванных форм подрезки ската, можно установить подрезку, параллельную плоскости этажа, а также установкой флажка Apply on All Edges (Применить ко всем краям) распространить действие команды на все края выбранного ската.
Построение крыш
ArchiCAD предоставляет проектировщику несколько методов построения скатов. Этим методам соответствуют следующие кнопки, расположенные на информационной палитре:
– построение многоугольных скатов. Используется для проектирования крыш с формой скатов, задаваемой пользователем;
– построение прямоугольных скатов. С некоторой задержкой после нажатия данной кнопки пользователю предлагается выбрать один из двух методов построения ската: с ориентацией сторон по координатной сетке проекта и с поворотом относительно ее;
– построение многоскатной крыши. Полностью автоматическое построение крыши по заданному контуру ее основания;
– построение сводов и куполов. После нажатия данной кнопки предлагается выбрать один из двух методов построения: сводчатой крыши или купола. При выборе метода построения свода кнопка принимает вид
Чтобы автоматически построить многоскатную крышу, необходимо выполнить следующие действия.
1. Активировать инструмент Wall (Стена).
2. Открыть окно настройки параметров стен.
3. Установить высоту стены, равную 2800 от уровня этажа.
4. Построить контур стен здания, подобный показанному на рис. 5.18.
Рис. 5.18. План здания
5. Активировать инструмент построения крыш, нажав кнопку
палитры инструментов.
6. Нажать кнопку
информационной палитры, чтобы открыть окно настройки параметров крыш.
7. Установить возвышение ската крыши, равное 2700 от уровня этажа, и нажать кнопку OK.
8. Выбрать метод построения многоскатных крыш, нажав кнопку
информационной панели.
9. Последовательно обойти контур стен, щелкая кнопкой мыши на каждом внешнем углу. При правильной привязке указатель мыши должен принимать форму
в начальной точке обхода, форму
– на углах контура и в конечной точке обхода, которая должна совпасть с начальной.
После замыкания контура на экране появится окно PolyRoof Settings (Настройки многоскатной крыши) (рис. 5.19).
В поле Levels (Ярусы) указывается количество ярусов крыши (их может быть не больше четырех). Количество доступных полей для ввода параметров ярусов зависит от количества ярусов, указанного в поле Levels (Ярусы). В расположенных слева от каждого яруса полях вводится значение высоты соответствующего яруса, в таких же полях справа – уклон яруса.
В нижней левой части окна устанавливается форма подрезки торцов скатов, в нижней правой – толщина в поле Roof Thickness (Толщина крыши) и расстояние от проекции нижнего торца до проекции базовой линии в поле Eave Overhang (Свес).
Рис. 5.19. Окно настройки параметров многоскатной крыши
10. Нажать кнопку OK, чтобы завершить построение крыши.
Чтобы получить полное представление о построенном объекте, можно переключиться в окно просмотра и редактирования трехмерного изображения, нажав на клавиатуре клавишу F3 (рис. 5.20).
Рис. 5.20. Объемное изображение крыши
Если нажать кнопку Orbit (Облет)
то включится режим, при котором перемещение указателя мыши при нажатой левой кнопке приводит к динамическому изменению точки взгляда на объект. Включить / выключить этот режим в процессе просмотра можно также, нажав клавишу 0.
ПРИМЕЧАНИЕ
Если мышь имеет колесо прокрутки, то эта функция доступна без щелчка на этой кнопке. Изменение точки взгляда будет происходить при перемещении мыши с одновременно нажатыми клавишей Shift и колесом прокрутки мыши.
Изменяя точку взгляда на объект, убедитесь в правильности построения крыши. Если результат построения не соответствует вашим ожиданиям, то выделите крышу и, открыв окно настройки ее параметров, измените необходимые значения. Другой способ – удалить крышу и построить ее заново, введя необходимые значения в окне PolyRoof Settings (Настройки многоскатной крыши).
Остальные типы крыш строятся аналогично, и можно освоить соответствующие методы самостоятельно с помощью справочной системы.
Эта глава посвящена основным методам создания конструктивно-планировочной структуры архитектурного сооружения: поэтажному планированию, созданию и редактированию основных конструктивных элементов здания: стен, перекрытий, балок, колонн и крыш.
Материал данной главы и освоение рассмотренных приемов создания элементов конструкций позволят спроектировать каркас практически любого сооружения от фундамента до крыши.
Глава 6
Работа с библиотекой объектов
Виртуальное здание построено, однако это не конец проекта, а только его начало, ведь фундамент, голые стены и крыша – это подобие пещеры первобытного человека. В доме должны быть двери и окна, лестницы и мебель, отопление и освещение, водо– и газоснабжение, канализация, электросеть, сеть связи и много чего еще, носящего общее название «инфраструктура объекта».
Как быть, если таких объектов в проекте сотни? Рисовать каждое кресло или раковину? Конечно, нет. С системой ArchiCAD поставляются библиотеки готовых объектов, которые пользователь просто вставляет в нужное место, определив при необходимости их параметры: форму, размеры, ориентацию и т. д. Конечно, для этого объект должен быть спроектирован особым образом. Однако тонкости проектирования параметрических объектов нас пока не интересуют. Наша цель – научиться работать со встроенными библиотеками объектов ArchiCAD.
Работа с библиотекой стандартных элементов
Для работы с библиотекой объектов предназначен инструмент Object (Объект), кнопка активации которого расположена на палитре инструментов и имеет вид
Нажатие этой кнопки отображает на информационной палитре элементы управления параметрами этого инструмента (рис. 6.1).
Рис. 6.1. Информационная палитра инструмента Object (Объект)
Кнопка
открывает окно настройки параметров объекта (рис. 6.2).
Рис. 6.2. Окно работы с библиотекой объектов
Вид данного окна заметно отличается от вида рассмотренных ранее окон установки параметров других инструментов, поскольку это окно является не только контейнером для элементов управления настройкой параметров объекта, но и инструментом работы с библиотекой объектов ArchiCAD.
Отличие определяется, прежде всего, наличием в левой части окна двух областей: области, представляющей иерархическую структуру библиотеки объектов ArchiCAD, и области представления и выбора объекта.
Расположение, вид и видимость этих областей можно изменять. Во-первых, их можно убрать с экрана, нажав вертикальную кнопку, отделяющую эти области от области установки параметров объекта. Во-вторых, можно изменить относительное расположение этих областей, нажав кнопку
расположенную в левом верхнем углу окна, вызвав панель с кнопками выбора относительного расположения областей (рис. 6.3).
Рис. 6.3. Панель выбора относительного расположения областей
Три кнопки соответствуют трем вариантам расположения областей: при первом варианте эти области располагаются одна под другой, при втором – рядом друг с другом, при третьем – отображается только область представления и выбора объекта.
Над областью структуры библиотеки расположен открывающийся список, состоящий из трех способов представления этой области:
□ Folder View (В виде папок) – отображение в виде иерархической структуры библиотеки объектов;
□ Subtype View (По типам объектов) – отображение с группировкой объектов по их типам;
□ Find Library Parts (Найти части библиотеки) – предназначен для поиска объектов в библиотеке по наименованию искомого.
У области представления и выбора объектов свои инструменты. Открывающийся список, расположенный над этой областью, позволяет перемещаться по структуре библиотеки, а кнопки, расположенные справа от этого списка, помогают представить набор объектов в необходимом виде.
Справа от кнопки
находится кнопка Load Other Object (Загрузить другие объекты), нажатие которой открывает меню, где можно выбрать следующие способы загрузки других объектов в библиотеку:
□ from File Dialog Box (Из Проводника) – открывается обычное окно Проводника Windows, с помощью которого выбирается файл, содержащий новые объекты;
□ Open Library Manager (Открыть менеджер библиотек) – запускается специальная программа, предназначенная для управления библиотеками объектов проекта.
Последний пункт меню является ссылкой на раздел сайта компании Graphisoft, содержащий информацию, связанную с разработкой библиотечных объектов.
Правая область рассматриваемого окна предназначена для настройки параметров выбранного объекта и его просмотра. Кнопки
и
предназначены для прокрутки списка объектов в прямом и обратном направлениях, а ряд кнопок слева от отображения выбранного объекта позволяет управлять его видом. С их функциями можно ознакомиться самостоятельно.
Проектирование дверей
Для создания дверей нужно нажать кнопку палитры инструментов Door (Дверь)
– на информационной палитре появятся элементы управления настройкой параметров двери (рис. 6.4).
Рис. 6.4. Элементы управления настройкой параметров двери
Настройка параметров двери
Нажатие кнопки
откроет окно Door Default Settings (Настройки параметров двери по умолчанию) (рис. 6.5).
Не стоит пугаться обилия параметров. Их большое количество говорит о возможности воплотить в жизнь практически любую фантазию. Рассмотрим настройку только основных параметров дверей, с остальными пытливый читатель ознакомится самостоятельно.
Листая с помощью кнопок
и
список имеющихся объектов, можно выбрать вид двери. Кнопками Anchor Point (Точка привязки) выбирается способ привязки двери к стене: к центру или краю дверного проема. Справа от этих кнопок расположены следующие кнопки для выбора способа монтажа двери в стену:
– заподлицо с плоскостью стены;
– с отступом в толщу стены, без четвертей;
– с отступом в толщу стены, с четвертями.
Глубина заложения двери в стену вводится в поле, которое становится доступным при выборе одного из двух последних способов монтажа.
Кнопка Flip (Зеркально) становится доступной, если окно открыто для изменения параметров уже имеющейся в проекте двери. Использование данной кнопки изменит сторону открытия двери на противоположную.
Кнопка Empty Opening (Проем) служит для вставки в стену пустого проема.
Рис. 6.5. Окно настройки параметров двери
В правой части раздела Parameters (Параметры) расположены поля для ввода ширины и высоты двери. Открывающийся список содержит способы привязки двери к основанию стены (Sill to Wall Base) или уровню этажа (Sill to Story), причем в качестве точки привязки можно выбрать основание (Sill) или притолоку (Header) двери. При необходимости можно добавить к высоте привязки постоянную величину, поле для ввода которой расположено под полем ввода высоты точки привязки.
Левая часть раздела Parameters (Параметры) содержит в себе все параметры объекта. При необходимости можно корректировать их прямо в этом окне, но удобнее делать это в специально предназначенных окнах соответствующего раздела.
Главный раздел настройки параметров двери – Intern al Door Settings (Параметры внутренней двери). Основной элемент управления – кнопка Door Size Settings (Размеры двери), открывающая меню подразделов (рис. 6.6).
Рис. 6.6. Меню подразделов параметров внутренней двери
ВНИМАНИЕ
Заголовок раздела изменяется в зависимости от типа выбранного объекта. На пример, при выборе входной двери заголовок раздела будет Entrance Door Settings (Параметры входной двери) и т. п. То же относится и к упомянутой кнопке.
Подразделы данного меню включают в себя разнообразные настройки для определения параметров двери:
□ Door Size Settings (Размеры двери) – устанавливаются номинальные размеры двери для выбранного способа измерения (по дверному проему, дверной коробке, проходу или дверной панели);
□ General Settings (Общие настройки) – определяются ограничения на величину открытия створок, параметры обналички и порогов, вид уплотнения, параметры монтажа при установке двери с отступом в толщу стены с четвертями, а также степень подробности изображения двери на плане этажа и в объемном изображении;
□ Door Frame (Косяк) – обозначаются вид, положение, размеры и другие параметры дверного косяка;
□ Door Panel (Дверная панель) – выбирается тип панели (стеклянная, филенчатая, с остеклением и т. д.), настраиваются параметры дверной панели, включая тип и расположение дверных ручек, наличие и размеры средников и т. п.;
□ Elevation and opening (Возвышение и открывание) – определяются относительная ширина створок двери (для двустворчатых дверей), угол открытия, тип и цвет линий для отображения двери на плане и в трехмерном изображении;
□ Casing (Обналичка) – настраиваются всевозможные параметры обналички двери, включая вид, расположение и размеры элементов обналички;
□ Threshold and Head (Порог и притолока) – выбираются вид, размеры, материал и параметры отображения порога и притолоки;
□ Shutter (Створка) – выбирается вид и настраиваются параметры створок, ставней (для окон) и жалюзи;
□ Cavity Closure (Уплотнения) – определяются геометрические размеры, метод, параметры монтажа и способ отображения дверных уплотнений;
□ Custom Reveal (Параметры четвертей) – настраиваются параметры монтажа при установке двери с отступом в толщу стены с четвертями;
□ Masonry Arch (Арка) – выбирается тип и настраиваются параметры дверного перекрытия;
□ Parameters for Listing (Дополнительные параметры) – здесь расположены поля для ввода дополнительной информации, в частности, площади и периметра остекления, наименования фирмы-производителя, параметров теплопроводности, огнеустойчивости, звукоизоляции, цены и т. п., включая поля для ввода произвольных характеристик.
ПРИМЕЧАНИЕ
Состав и доступность разделов и элементов управления настройками параметров двери зависит от выбора типа двери и установки конкретных значений параметров.
Создание дверей
Создать дверь просто. После выбора инструмента Door (Дверь), настройки ее параметров и выбора места вставки программа ArchiCAD, в соответствии с типом и установленными параметрами вырезает в стене необходимый проем и вставляет туда дверь. Основное время уходит на настройку параметров, после чего спроектированный тип двери, во-первых, можно сохранить с помощью кнопки Favorits (Избранное), во-вторых, поскольку дверь является обычным объектом ArchiCAD, ее можно копировать, перемещать, размножать, то есть выполнять многие действия, предназначенные для редактирования объектов ArchiCAD. Рассмотрим пример создания входной двустворчатой двери. Для этого необходимо выполнить такую последовательность действий.
1. Активизируйте первый этаж проекта.
2. С помощью инструмента Wall (Стена) постройте стену в виде прямоугольного замкнутого контура со следующими параметрами: возвышение стены – 0, высота – 3000 и толщина – 300.
3. Активизируйте инструмент Door (Дверь), нажав соответствующую кнопку палитры инструментов.
4. Вызовите окно настройки параметров двери, нажав кнопку
5. Найдите в библиотеке дверь с именем D2 11 и щелкните на ее изображении кнопкой мыши.
6. Настройте следующие параметры раздела Preview and Positioning (Просмотр и размещение):
■ с помощью кнопки Anchor Point (Точка привязки) установите точку привязки двери по центру двери;
■ выберите способ привязки двери к стене с отступом в толщу стены без четвертей, используя кнопку
■ установите глубину закладки двери, равную 70 мм.
7. Установите флажки Casing Out (Наружная обналичка) и Casing In (Внутренняя обналичка) в подразделе General Settings (Общие настройки) раздела Internal Door Settings (Параметры внутренней двери).
8. В подразделе Elevation and Opening (Возвышение и открывание) установите значение полей Angle in 3D (Угол открытия в объеме) и Angle in 2D (Угол открытия в плане) равным 45°.
9. В подразделе Door Panel (Дверная панель) настройте следующие параметры:
■ выберите вид дверной панели Style 2;
■ нажмите кнопку, расположенную в группе элементов управления Handle (Ручка);
■ выберите ручку Style 4 из открывшегося списка.
10. Нажмите кнопку OK – параметры двери будут настроены.
Теперь построим дверь, выполнив следующие действия.
1. Переместите указатель мыши к середине нижней (в плане) стены так, чтобы он принял форму
2. Щелкните кнопкой мыши – в стене появится проем, а указатель мыши примет форму
3. Установите указатель мыши снаружи контура стены – этим вы укажете сторону открытия двери – наружу.
4. Определите место крепления двери, сместив указатель мыши от центра проема ближе к той стороне, где будут находиться петли.
5. Щелкните кнопкой мыши, чтобы завершить построение.
На плане объекта в стене появится условное обозначение двери (рис. 6.7, а).
Переключитесь в окно трехмерного отображения и редактирования объекта и посмотрите результат построения (рис. 6.7, б).
а
б
Рис. 6.7. Изображение двери на плане этажа (а) и в объеме (б)
Многие вещи ArchiCAD делает автоматически. В частности, при выполнении рассмотренного примера ширина дверной коробки автоматически была подогнана по толщине стены. Если необходимо лишить ArchiCAD «самостоятельности», то следует снять флажок Frame Thickness=Wall Thickness (Ширина дверной коробки равна толщине стены), расположенный в подразделе Door Frame (Косяк), и установить в соответствующем поле того же подраздела конкретную ширину косяка.
Проектирование окон
Для создания окон предназначена кнопка Window (Окно)
расположенная в разделе Design (Проектирование) палитры инструментов. Использование данной кнопки отображает на информационной палитре элементы управления настройками параметров окон (рис. 6.8).
Рис. 6.8. Палитра управления в режиме построения окна Настройка параметров окна
Рассмотрим параметры окон в диалоговом окне их настроек по умолчанию (рис. 6.9), открываемом кнопкой
расположенной на информационной палитре.
Рис. 6.9. Окно настройки параметров окон
Многие параметры дверей и окон совпадают по своему назначению, так как окна и двери схожи между собой. Оба объекта вставляются в стену, для чего в ней вырезается проем. Оба имеют длину и ширину, створки, могут иметь обналичку и т. д. Но есть и различия.
Раздел установки параметров дверей в рассматриваемом окне заменен разделом установок параметров окон. Название раздела настройки основных параметров, так же как и в окне настройки параметров дверей, меняется в зависимости от типа выбранного окна, изменены некоторые названия его подразделов, состав параметров и т. д. Остановимся только на тех элементах настройки, в которых произошли изменения:
□ General Settings (Общие настройки) – в этом подразделе настройки порога заменены настройками подоконника;
□ Frame and Sash (Рама и переплет) – данный подраздел введен вместо подраздела Door Frame (Косяк);
□ Elevation and Opening (Возвышение и открывание) – параметры открывания дверных створок заменены параметрами определения вида и способа открывания фрамуг и форточек;
□ Sash Options (Параметры переплета) – этот подраздел заменил собой подраздел Door Panel (Дверная панель), здесь определяется вид и устанавливаются параметры оконного переплета;
□ Sill, Board and Head (Отлив, подоконник и перевязка) – введен вместо подраздела Threshold and Head (Порог и притолока), здесь определяется наличие, вид и настраиваются параметры отливов и подоконников;
□ Custom Reveal (Параметры четвертей) – в данном подразделе можно дополнительно определить параметр Parapet Wall Inset (Глубина оконной ниши).
Еще раз напомним, что наличие и доступность в окне настроек параметров объекта конкретных разделов, подразделов, элементов управления, а также их наименований зависят от типа выбранного объекта и установок его параметров.
Создание окон
Чтобы создать окно, необходимо выполнить приведенную ниже последовательность действий.
1. Активизировать этаж с построенным в предыдущем примере контуром стены.
2. Нажать кнопку
палитры инструментов.
3. Открыть окно настройки параметров окна, нажав кнопку
4. Найти в библиотеке окно с именем W2 Casement HDiv И и щелкнуть на его изображении кнопкой мыши.
5. В разделе Preview and Positioning (Просмотр и размещение) настроить следующие параметры:
■ используя кнопку Anchor Point (Точка привязки), установить привязку окна по центру;
■ выбрать способ привязки окна к стене с отступом в толщу стены, без четвертей, используя кнопку
■ установить глубину закладки окна в стену равной 120 мм.
6. Установить флажки Casing Out (Наружная обналичка), Casing In (Внутренняя обналичка) и Sill In (Внутренний отлив) в подразделе General Settings (Общие настройки) раздела Casement Window Settings (Установки параметров окна). Остальные флажки нужно снять.
7. Нажать кнопку OК, чтобы завершить настройку параметров окна.
8. Щелкнуть кнопкой мыши на плане стены – в стене появится проем, а указатель мыши примет форму
9. Указать сторону открытия окна – наружу, переместив указатель мыши вне контура стены.
10. Щелкнуть кнопкой мыши, чтобы завершить построение.
Процесс построения окна ничем не отличается от процесса построения двери. На плане объекта в стене появится условное обозначение окна. Следует переключиться в окно трехмерного отображения и редактирования объекта и посмотреть результат построения (рис. 6.10).
Перейдите в режим редактирования объекта, выбрав построенное окно, и, изменяя его настройки, уточните параметры окна, если это необходимо.
В ArchiCAD имеются еще два объекта, связанные с окнами, – угловые окна и световые люки. Кнопка активизации инструмента построения угловых окон Corner Window (Угловое окно)
по умолчанию отсутствует на палитре инструментов. Вызвать ее можно командой главного меню ArchiCAD Design ► Design Tools ► Corner-Window (Проектирование ► Инструменты проектирования ► Угловое окно).
Угловое окно при его создании привязывается к ближайшему от указанной точки вставки углу стены. Кроме места вставки и внешнего вида, это окно ничем не отличается от обычных, поэтому подробно рассматривать его нет смысла.
Инструмент построения световых люков вызывается кнопкой Skylight (Световой люк)
расположенной на палитре инструментов.
Основные параметры световых люков – размеры конструкционных элементов рамы люка, количество световых проемов и их форма, которая может быть плоской, прямоугольной, призматической, круглой и т. п.
Рис. 6.10. Результат построения окна
В том же разделе библиотеки, что и световые люки, находятся мансардные окна, настройки основных параметров которых, определяющие внешний вид этих объектов, расположены в разделе Parameters (Параметры).
Проектирование лестниц
Один из самых интересных объектов библиотеки ArchiCAD – лестницы. Инструмент построения лестниц активизируется нажатием кнопки Stair (Лестница)
расположенной на палитре инструментов. При этом на информационной палитре открываются элементы управления настройками параметров лестниц (рис. 6.11).
Рис. 6.11. Элементы управления настройкой параметров лестниц
Настройка параметров лестниц
Окно Stair Default Settings (Настройки параметров лестниц по умолчанию) (рис. 6.12) открывается нажатием кнопки
Рис. 6.12. Окно настройки параметров лестниц
В разделе Preview and Positioning (Просмотр и расположение) расположены следующие параметры:
□ кнопки перемещения по разделу лестниц библиотеки объектов ArchiCAD в прямом
и обратном
направлениях;
□ окно предварительного просмотра лестниц;
□ кнопки определения способа представления лестниц в окне предварительного просмотра;
□ кнопка
выбора действия над текущим объектом;
□ поля для ввода возвышения основания лестницы относительно уро в ня текущего этажа и нулевого уровня проекта (альтернативного уровня);
□ открывающийся список выбора видимости лестницы на этажах проекта.
В разделе Parameters (Параметры) расположены основные параметры лестниц. В правой части раздела расположены четыре поля для ввода следующих параметров:
□ длины заложения лестницы;
□ ширины лестничного марша;
□ высоты подъема лестницы;
□ угла поворота лестницы.
Последний параметр определяет угол поворота лестницы в плане относительно принятой системы координат.
Доступность этих параметров определяется типом лестницы, поскольку при выборе, например, винтовой лестницы нет смысла говорить о длине ее заложения, ширина лестничного марша может быть непостоянной и т. д.
Основные параметры лестницы находятся в списке левой части раздела Parameters (Параметры) и расположены в следующих подразделах:
□ Tread and Riser Sizes (Размеры ступеней) – определяются такие параметры лестницы, как количество ступеней на маршах, геометрические размеры элементов ступени, материал ступеней;
□ Stair and Landing Slab (Лестница и площадка) – устанавливаются параметры лестничной площадки;
□ Rail (Ограждения) – из открывающегося списка выбирается наличие и размещение лестничного ограждения: None (Отсутствует), Right (Справа), Left (Слева) и Both (C обеих сторон) (при наличии ограждения в списке параметров появляются дополнительные элементы для настройки параметров лестничных ограждений).
В остальных подразделах можно посмотреть и установить такие параметры, как способы отображения и видимость лестниц на разных видах и в разных масштабах, материалы конструкционных элементов лестниц для отображения в проекте и составления смет.
В разделе 2D Symbols, Arrowhead, Batten, Flight and Railing Types (Типы условных обозначений, размерных элементов, отделки, лестничных маршей и ограждений), который появляется в окне при выборе стандартной лестницы, настраиваются дополнительные параметры. Нажатие верхней кнопки
этого раздела открывает список выбора настраиваемых параметров для отображения лестницы на плане этажа (рис. 6.13).
Рис. 6.13. Список выбора настраиваемых параметров отображения
Типы выбранного параметра отображаются в окне, расположенном в нижней части раздела, необходимый тип выбирается с помощью мыши.
Для параметра 2D Symbol Types (Типы условных обозначений) список отображаемых типов зависит от выбора уровня детализации условного обозначения в зависимости от масштаба чертежа. Сделать выбор можно, нажав нижнюю кнопку
Остальные разделы данного окна уже рассматривались во время работы с предыдущими объектами.
Создание и редактирование лестниц
Чтобы вставить в план лестницу, нужно выполнить следующие действия.
1. Нажать кнопку
палитры инструментов.
2. Открыть окно настройки параметров лестниц, нажав кнопку
3. Выбрать необходимый тип лестницы из библиотеки объектов и настроить ее параметры.
4. Закрыть окно настройки параметров лестниц, нажав кнопку ОК.
5. Переместить указатель мыши к точке вставки лестницы и щелкнуть кнопкой мыши, чтобы завершить построение лестницы.
Если выделить вставленную лестницу, то на ней, как и на всех других объектах, появятся характеристические точки, с помощью которых можно редактировать ее геометрические размеры. Кроме черных точек на плане лестницы можно увидеть и розовые ромбики. С помощью этих элементов управления можно менять длину заложения, ширину и длину маршей лестницы, угол их подъема и т. д.
Источники света
Источники света – такие же объекты библиотеки ArchiCAD, как и рассмотренные выше, однако к ним невозможно получить доступ, используя инструмент Object (Объект). Дело в том что основное отличие источников света от других объектов – это возможность излучения света раз личной интенсивности. Поэтому при помещении источников света в проектируемый объект его интерьер изменяется не только за счет наличия или отсутствия источника света как такового, но и за счет изменения внешнего вида других объектов, находящихся в зоне действия света. В связи с этим для работы с источниками света имеется отдельный инструмент, который можно вызвать командой меню Design ► Design Tools ► Lamp (Проектирование ► Инструменты проектирования ► Источник света). При необходимости можно добавить кнопку активации этого инструмента
на палитру инструментов. В результате на информационной палитре появятся элементы управления настройкой параметров источников света (рис. 6.14).
Нажатие кнопки
открывает окно Lamp Default Settings (Настройки источников света по умолчанию) (рис. 6.15).
Рис. 6.14. Элементы управления настройкой параметров источников света
Основное отличие этого окна от окон других объектов – наличие в разделе Parameters (Параметры) ползункового регулятора Light Intensity (Интенсивность излучения). С помощью ползунка или путем ввода значения в расположенное справа от регулятора поле можно изменять яркость источника света. Двойной щелчок кнопкой мыши на поле Color (Цвет) вызовет палитру выбора цвета излучения, а нажатие кнопки
и кнопки
позволит включать или отключать источник света.
СОВЕТ
Используйте эти возможности для определения условий внутреннего и наружного освещения. Включением, отключением, регулированием яркости и изменением место расположения источников света можно добиться наиболее эффектного и эффективного освещения проектируемого объекта в различных режимах его эксплуатации.
В разделе Parameters (Параметры) добавлен специфичный для источников освещения подраздел Light Settings (Настройки источников света). Здесь можно установить внутренние и внешние углы и радиусы рассеивания светового конуса, определить видимость светового конуса при создании фотореалистичного изображения проектируемого объекта и определить многие другие параметры источника света в зависимости от его типа. При выборе светильников в окне появляется раз дел Lamp Settings (Настройки светильника) (рис. 6.15), в котором для изменения вышеуказанных параметров, в том числе конструкционных, используется простой и понятный интерфейс.
ПРИМЕЧАНИЕ
Не путайте понятия источника света и светильника! Под светильником обычно понимается какое-то физическое тело, излучающее свет, а в ArchiCAD имеются объекты, излучающие свет, но не имеющие тел. В библиотеке источников света можно найти такие объекты, как General Light 11 (Общее освещение), Light Cone Up 11 (Свет, восходящий снизу), Light Cone Down 11 (Свет, падающий сверху) или Spot Light 11 (Световое пятно). Эти объекты помогают создать дополнительные эффекты освещения, которые встречаются в реальном мире, когда мы видим свет, создаваемый источником, находящимся вне поля нашего зрения.
Рис. 6.15. Параметры настройки источников света
Кроме того, несколько десятков типов собственно светильников, от настольных ламп до уличных фонарей, – помогут на первых порах осветить интерьер и место расположения проектируемого здания.
В этой главе была рассмотрена библиотека объектов ArchiCAD, ее структура и принципы работы с ней, изучены способы настройки параметров объектов и их вставки в проект. Теперь можно самостоятельно проектировать двери и окна, настраивать их параметры, определять их вид и положение в пространстве.
В главе представлены также процессы настройки параметров и создания лестниц и источников освещения, указано расположение в стандартной библиотеке ArchiCAD большей части объектов, которые необходимо использовать для создания полной инфраструктуры проектируемого здания.
Глава 7
Работа со слоями
В этой главе рассматривается одна из наиболее значимых возможностей ArchiCAD – логическое группирование объектов, обеспечивающее гибкий механизм визуального представления объектов и предохранения их от непреднамеренного изменения.
Общие сведения о слоях
Слои – один из мощных механизмов визуального представления объектов, обеспечивающий при умелом использовании максимально удобную работу с проектной документацией.
На чертеже плана этажа должны располагаться изображения конструктивных элементов здания, элементов систем водоснабжения и канализации, силовых и коммуникационных кабельных систем, разнообразные условные обозначения, технические требования и размеры и т. д. Если всю эту информацию попытаться разместить на одном листе, то вряд ли можно будет что-либо понять. Проектировщики и конструкторы давно нашли выход из этого положения: для каждого вида информации существуют свои типы чертежей, поэтому объекты, логически относящиеся к разным системам, располагаются на отдельных листах. Однако при разработке проекта в ArchiCAD разрабатываемый объект – это не набор чертежных листов, а виртуальная модель, в которой каждый элемент должен находиться на своем месте. Как быть?
Здесь и приходят на помощь слои – механизм, широко используемый в автоматизированных системах, связанных с обработкой графической информации. Слои позволяют логически разделить объекты, проекции которых визуально могут накладываться друг на друга, затрудняя человеку восприятие информации.
Слой в ArchiCAD – это имеющая имя совокупность атрибутов, которая может быть приписана определенным объектам. В таком случае говорят, что объекты находятся на данном слое. Что это за атрибуты, каково их назначение, каким образом объекты соотносятся с определенным слоем – все эти вопросы рассматриваются в данной главе.
Управление слоями
Элементы управления слоями и атрибуты слоев рассмотрим на примере стандартного списка слоев ArchiCAD.
Окно управления слоями Layer Settings (Настройки слоя) (рис. 7.1) можно вызвать несколькими способами:
□ командой Document ► Layers ► Layer Settings (Документ ► Слои ► Настройки слоя);
□ командой Options ► Element Attributes ► Layer Settings (Параметры ► Атрибуты элементов ► Настройки слоя);
□ нажатием кнопки
которая находится на информационной панели при любом активном инструменте построения объектов рядом с кнопкой вызова окна настройки параметров объекта;
□ нажатием кнопки
панели Arrange Elements (Упорядочивание объектов);
□ нажатием комбинации клавиш Ctrl+L.
Рис. 7.1. Окно управления слоями
ПРИМЕЧАНИЕ
Как и во всех предыдущих случаях работы с окнами, объектами и т. д., рекомендуется использовать комбинацию клавиш, которая действует вне зависимости от видимости панелей или меню.
Окно Layer Settings (Настройки слоя) имеет две области. Как и при работе с окном библиотеки объектов, рассмотренным в предыдущей главе, отображение левой области можно отключить нажатием кнопки, разделяющей эти области.
Рассмотрение слоев начнем с правой области – Layers (Слои), где расположен список имеющихся в проекте слоев и элементы управления слоями.
Список слоев состоит из наименования слоя, слева от которого расположены следующие четыре атрибута.
□ Атрибут блокирования слоя – значок
обозначает слой, объекты которого доступны для редактирования, значок
красного цвета помечает слой, объекты которого нельзя изменить, переместить или удалить, на заблокированный слой нельзя также помещать другие объекты.
□ Атрибут видимости слоя – если объекты, находящиеся на слое, видимы, то в поле стоит значок
в противном случае – значок
□ Атрибут объемного изображения – значок
определяет представление объектов слоя в 3D-окне в виде твердотельного изображения, значок
представляет объекты слоя в виде каркасной модели.
Поскольку эти атрибуты имеют взаимно противоположные значения, то управлять ими просто: щелчок на значке переводит атрибут в противоположное состояние.
□ Атрибут пересечения объектов, над которым находится кнопка
– объекты с одинаковым номером, даже если они расположены на разных слоях, будут взаимодействовать при их взаимном пересечении. Под взаимодействием понимается, например, сопряжение однотипных объектов, отображение объектов в соответствии с приоритетом их видимости и т. п. Объекты, имеющие разные номера, не будут взаимодействовать при пересечении, даже если они находятся на одном слое.
СОВЕТ
Если необходимо создать объекты, которые не должны взаимодействовать с другими, разместите их на слое с номером поля пересечения, равным 0.
□ Атрибут Extension (Расширение), расположенный справа от имени слоя, – позволяет присвоить слою произвольную информацию, по которой можно сортировать или упорядочивать слои в списке.
Выбрать способ сортировки можно, нажав кнопку, расположенную справа от значка
– станут доступными следующие три варианта:
□ Show all layers (Показать все слои) – отображаются все слои, определенные в проекте;
□ Hide Xref layers (Скрыть Xref-слои) – технология Xref предназначена для использования в проекте файлов формата DWG и DXF – чертежей популярной САПР AutoCAD, на каждый такой файл создается ссылка, которая связывается со специальным слоем, выбор этого варианта сортировки скрывает слои, связанные с Xref-ссылками;
□ Filter by extension (Фильтровать по расширению) – в списке отображаются только слои с одинаковой информацией в атрибуте Extension (Расширение).
Упорядочить записи можно, щелкнув кнопкой мыши на заголовке атрибута. Если щелкнуть на заголовке текстового атрибута (к ним относятся три последних), то записи упорядочатся по алфавиту в соответствии со значением данного атрибута. При щелчке на заголовке атрибута блокирования сначала будут отображены неблокированные слои, затем блокированные. Если щелкнуть на заголовке атрибута видимости, то сначала отобразятся видимые слои, затем невидимые, а при активизации заголовка атрибута объемного изображения слои с объемным изображением расположатся выше, чем слои с каркасным.
Щелчок кнопкой мыши на текстовом атрибуте слоя переводит его в режим редактирования, что позволяет изменить значение атрибута.
Возможности выделения записей списка слоев полностью совпадают с выделениями объектов Windows. Можно выделить несколько записей протаскиванием мыши с нажатой кнопкой. Можно выделять произвольно расположенные записи щелчком кнопкой мыши при нажатой клавише Ctrl. Щелчок кнопкой мыши при нажатой клавише Shift выделит все записи от выделенной до той, на которой произведен щелчок, и т. д.
Нажатие комбинации клавиш Ctrl+A или использование кнопки Select All (Выделить все), расположенной справа от списка слоев, выделит все объекты. Нажатие кнопки Deselect All (Снять все выделение) снимает выделение со всех слоев.
Кнопки, расположенные справа от списка слоев, обеспечивают работу с группой выделенных записей. Нажатие кнопки Lock (Блокировать) блокирует выделенные слои, кнопки UnLock (Разблокировать) – разблокирует. Кнопка Show (Показать) делает видимыми, а кнопка Hide (Скрыть) соответственно – невидимыми объекты на всех выделенных слоях. С помощью кнопки Delete (Удалить) выделенные слои можно удалить.
ВНИМАНИЕ
При удалении слоев безвозвратно удаляются и все расположенные на них объекты, причем это действие необратимо.
Новый слой создается нажатием кнопки New (Создать). В появившемся окне необходимо указать имя нового слоя, и он появится в списке слоев.
Кнопка Print (Печать) предназначена для распечатки текущего состояния слоев и их комбинаций.
Комбинации слоев
Иногда слой должен иметь одно значения атрибута, иногда – другое. Например, при простановке размеров слой размерных записей должен был видимым, тогда как при работе с другими объектами он будет только мешать. Структурная сетка осей, которая тоже является одним из объектов, при редактировании других объектов должна быть заблокирована от случайных изменений, а если необходимо изменить ее параметры, то нужно ее разблокировать.
Разрешаются подобные ситуации в ArchiCAD путем использования механизма комбинации слоев. Комбинация слоев – это конкретный вариант установленных атрибутов всей совокупности слоев, имеющий имя. Список комбинаций слоев расположен в левой области окна – Layer Combinations (Комбинации слоев) (см. рис. 7.1).
Записи списка комбинаций слоев, как и записи списка слоев, являются составными. Они включают в себя номер комбинации слоя, ее наименование и атрибуты активного слоя.
Кнопки New (Создать), Update (Изменить) и Delete (Удалить), расположенные под списком комбинаций слоев, выполняют соответствующие действия по отношению к комбинациям слоев.
Чтобы изменить комбинацию слоев, необходимо выделить ее, изменить атрибуты в списке слоев и нажать кнопку Update (Изменить).
Для создания новой комбинации слоев нужно предварительно установить необходимые значения атрибутов в списке слоев, создав при необходимости новые слои и установив их атрибуты, затем нажать кнопку New (Создать), ввести наименование новой комбинации слоев и закрыть окно создания комбинации слоев, используя кнопку OK.
ПРИМЕЧАНИЕ
При удалении комбинации слоев сами слои не удаляются, так как комбинация слоев – это не совокупность слоев подобно папке с расположенными в ней файлами, а только список атрибутов слоев.
Создание слоев и комбинаций слоев
По описанию инструмента, каким бы подробным оно ни было, достаточно сложно, особенно для начинающего пользователя, понять принцип его функционирования. Список слоев и комбинаций слоев в стандартной поставке ArchiCAD слишком объемен и сложен, чтобы в нем можно было быстро разобраться. Гораздо проще понять принцип работы этого механизма на простом примере.
Предположим, необходимо выполнить следующие условия:
□ работа будет происходить со стенами и балками порознь, то есть при работе со стенами балки не должны быть видимы, при работе с балками не должны мешать стены;
□ как при работе со стенами, так и при работе с балками должна быть видима структурная сетка осей;
□ структурная сетка должна быть заблокирована от случайных изменений в процессе работы с объектами;
□ после завершения работы должна иметься возможность просмотра готового объекта, то есть нужна совместная видимость созданных стен и балок без возможности их изменения, но чтобы в этом случае структурная сетка не мешала просмотру;
□ для настройки параметров структурной сетки должна иметься возможность ее редактирования, но чтобы при этом не мешали стены и балки.
Вполне законные, но в определенном смысле противоречивые требования. То балки и стены не должны мешать друг другу, то необходим их совместный просмотр. То структурная сетка должна быть видима совместно с балками и стенами, то не должна. Как быть?
Как ни удивительно, но все это можно сделать, используя механизм слоев ArchiCAD.
Сначала избавимся от многочисленных, но пока непонятных слоев, присутствующих в каждом проекте по умолчанию, выполнив такую последовательность действий.
1. Создайте новый проект.
2. Вызовите окно установки параметров слоев нажатием комбинации клавиш Ctrl+L.
3. Нажмите кнопку Select All (Выделить все) – все слои, находящиеся в списке слоев, будут выделены.
4. Нажмите кнопку Delete (Удалить), расположенную справа от списка слоев, – в списке слоев останется только неудаляемый и неизменяемый слой ArchiCAD Layer (Слой ArchiCAD). Этот слой существует для того, чтобы в случае «пропажи» объектов при манипуляциях со слоями эти объекты не исчезали. Если объект по злому умыслу или досадной случайности стал «бесхозным», то есть не принадлежащим ни одному слою, то он автоматически попадет на слой ArchiCAD Layer (Слой ArchiCAD).
5. Удалите все комбинации слоев, последовательно выделяя их кнопкой мыши в левой области окна комбинации слоев и нажимая клавишу Delete (Удалить), расположенную под этим списком.
Подготовительная работа завершена. Списки слоев и их комбинаций очищены. Теперь необходимо создать три слоя, потому что по условию задачи мы работаем с тремя объектами: стенами, балками и структурной сеткой, которые должны быть независимы друг от друга. Для этого нужно выполнить следующие действия.
1. Нажать кнопку New (Создать), расположенную справа от списка слоев Layers (Слои), – откроется окно для ввода имени нового слоя.
2. Введите имя Стены и нажмите кнопку OK – в списке слоев появится новый слой.
3. Повторите пункты 1-2, введя имена Балки и Сетка, – список слоев создан (рис. 7.2).
Теперь создадим комбинации слоев. Первая комбинация – для работы со стенами. Для ее создания понадобится выполнить следующие действия.
1. Для выключения видимости балок нажмите кнопку
слоя Балки – данный значок заменится изображением
2. Нажмите кнопку
слоя Сетка – значок изменится и примет вид
Теперь слой Сетка заблокирован, то есть объекты, расположенные на нем, недоступны для изменения.
Рис. 7.2. Создание списка слоев
Таким образом, выполнено первое условие, касающееся работы со стенами: слой Стены видим и доступен для редактирования, слой Балки невидим, слой Сетка видим, но недоступен. Сохраним данную комбинацию под именем Стены.
Для этого следует нажать кнопку New (Создать), расположенную в левом нижнем углу области Layer Combinations (Комбинации слоев), – откроется окно, в котором следует ввести имя Стены и нажать кнопку OK. Комбинация слоев для работы со стенами создана (рис. 7.3).
Чтобы настроить слои, необходимо выполнить следующие действия.
1. Включите видимость слоя Балки и отключите видимость слоя Стены – таким образом подготовлена комбинация слоев для построения балок.
2. Создайте эту комбинацию, назвав ее Балки.
3. Создайте комбинацию слоев Просмотр, включив видимость слоев Стены и Балки, заблокировав их и отключив видимость слоя Сетка.
4. Создайте комбинацию слоев Сетка, отключив видимость слоев Балки и Стены, разблокировав слой Сетка и включив его видимость. Слои и комбинации слоев настроены (рис. 7.4).
5. Проверьте правильность работы созданной структуры, пощелкав кнопкой мыши на элементах списка комбинаций слоев. При выделении комбинации в списке слоев изменятся соответствующие установки атрибутов списка Layers (Слои). Если вы заметили ошибку, то установите необходимые значения атрибутов слоев и нажмите ставшую доступной кнопку Update (Изменить). При выделении слоев можно видеть, как изменяются атрибуты списка комбинаций слоев.
Рис. 7.3. Создание комбинации слоев
Рис. 7.4. Результат создания комбинаций слоев
6. Закройте окно установки параметров слоев, нажав кнопку OK, – откроется окно с предупреждением: By deleting layers you lose all plan elements assigned to those layers. This operation is NOT UNDOABLE (Удаляя слои, вы потеряете все объекты, связанные с этими слоями. Эта операция НЕОБРАТИМА). Вспомним, что мы удалили все имевшиеся в проекте слои и их комбинации, прежде, чем создавать собственные. На самом деле удаленные слои были лишь помечены для удаления и стали невидимы.
7. Нажмите кнопку Delete anyway (Удалить) окна предупреждения – помеченные слои реально удалятся, а новые будут созданы.
Таким образом, завершена основная часть работы – настройка слоев. Перейдем к непосредственной работе с использованием слоев.
Сначала создадим структурную сетку осей. Это еще один элемент точных построений, о котором упоминалось в главе 3. Прежде всего, нужно настроить ее параметры, выполнив следующие действия.
1. Выполните команду Design ► Structural Greed (Конструирование ► Структурная сетка). Откроется окно Structural Greed (Структурная сетка) (рис. 7.5), в левом нижнем углу которого появилась кнопка Structural Greed (Структурная сетка), так как ArchiCAD при активизации окна настройки параметров структурной сетки восстановил удаленный нами соответствующий слой. Однако у нас есть свой слой для сетки.
2. Нажмите кнопку Structural Greed (Структурная сетка) – откроется список слоев, из которого следует выбрать слой Сетка. Теперь создаваемая сетка будет размещена на предназначенном для нее слое.
3. Перейдите на вкладку Attributes and Elements (Элементы и атрибуты).
4. Установите систему нумерации осей структурной сетки, выбрав A, B, C из открывающегося списка Horisontal Axis (Горизонтальные оси) и 1, 2, 3 из открывающегося списка Vertical Axis (Вертикальные оси).
5. Нажмите кнопку Options (Дополнительно).
6. В области Range (Порядок) установите направление отсчета сетки up (Вверх) для горизонтальных осей и right (Вправо) для вертикальных.
7. Закройте окно, нажав кнопку OK.
8. Перейдите на вкладку Form and Size (Форма и размеры).
9. В разделах Horizontal Grid Lines (Горизонтальные линии сетки) и Vertical Grid Lines (Вертикальные линии сетки) установите расстояния между осями A – B, B – C, 1-2 и 2-3, равные 6000.
10. Удалите остальные элементы этих разделов, выделяя их щелчком кнопкой мыши и нажимая после этого кнопку Delete (Удалить), расположенную под разделами.
11. Нажмите кнопку OK – параметры сетки настроены.
12. Переместите указатель мыши, установленный на пересечении нижней и левой осей сетки, в точку начала координат проекта, помеченную на плане этажа косым крестиком, и щелкните кнопкой мыши. Структурная сетка будет установлена.
Рис. 7.5. Окно Structural Grid (Структурная сетка)
Теперь построим объекты, для чего нужно выполнить следующие действия.
1. Нажмите кнопку
информационной панели – откроется окно установки параметров слоев.
2. Активизируйте комбинацию слоев Стены.
3. Щелкните кнопкой мыши на слое Стены – это сделает слой стены активным.
4. Закройте окно, нажав кнопку OK.
Обратите внимание, что на кнопке активизации слоев информационной панели появилась надпись Стены. Это означает, что строящиеся объекты будут помещены на активный слой, – в данном случае на слой Стены.
ПРИМЕЧАНИЕ
Если к моменту вызова меню слоев в проекте имеются выделенные объекты, то они будут перенесены на выбранный из списка слой.
5. Активируйте инструмент построения стен.
6. Постройте замкнутый контур стен в виде треугольника (рис. 7.6).
Рис. 7.6. Построение стен
7. Теперь активируйте комбинацию слоев Балки. Построенные стены исчезли, так как слой Стены в комбинации слоев Балки невидим. Это можно увидеть на кнопке активизации слоев.
8. Активируйте инструмент построения балок – надпись на кнопке активизации слоев изменилась на Missing (Отсутствует). Это означает, что инструмент построения балок не связан ни с одним слоем построения.
9. Нажмите кнопку активизации слоев, расположенную на информационной панели, и выберите слой Балки – строящиеся объекты, в данном случае балки, теперь будут связаны с этим слоем.
10. Постройте замкнутый контур балок в виде треугольника (рис. 7.7).
Построения стен и балок завершены. Каждый тип объектов связан со своим слоем, имеющим соответствующие атрибуты. Теперь можно посмотреть работу комбинации Просмотр. Для этого нужно открыть окно установки параметров слоев, активировать комбинацию слоев Просмотр и закрыть окно, нажав кнопку OK (рис. 7.8).
Рис. 7.7. Построение балок
Рис. 7.8. Активизация комбинации слоев Просмотр
Как видно на рисунке, структурная сетка исчезла, зато стены и балки видны одновременно. При выборе инструмента построения стен или балок надпись на кнопке активизации слоев отображается наклонным шрифтом, что означает блокирование слоя. При попытке создать объект или вызвать панель редактирования появляется окно с сообщением о невозможности выполнения задания и кнопками отмены действия, разблокирования слоя или выбора другого слоя.
Осталось рассмотреть работу механизма пересечения объектов. Сделаем это на примере построения стен.
В процессе построения стен их прямоугольные торцы были автоматически изменены системой для сопряжения в неразрывный контур (рис. 7.9, а).
Попробуем нарушить работу этого механизма. Выше было сказано, что сопряжение объектов не будет работать, если они находятся на слоях с разными номерами атрибутов пересечения. Атрибут пересечения присваивается слою, а все стены находятся на одном слое, поэтому нужно переместить какую-либо стену на слой, имеющий другой номер атрибута пересечения. Однако все слои имеют один номер группы – 1.
Изменим номер группы слоя Стены, например, на 2, а одну из стен переместим на слой ArchiCAD Layer (Слой ArchiCAD), имеющий номер 1. Для этого нужно выполнить следующие действия.
1. Активировать окно установки параметров слоев.
2. Изменить номер группы пересечения слоя Стены на 2.
3. Активировать комбинацию слоев Стены.
4. Закрыть окно, нажав кнопку OK.
5. Выделить левый верхний сегмент контура стен.
СОВЕТ
Если при попытке выделения сегмента выделяется весь контур, то используйте команду главного меню ArchiCAD Edit ► Grouping ► Ungroup (Редактор ► Группирование ► Разгруппировать) или комбинацию клавиш Ctrl+Shift+G для разгруппирования контура стен на отдельные сегменты, после чего повторите попытку выделения.
6. Откройте список активизации слоев.
7. Выберите из списка слой ArchiCAD Layer (Слой ArchiCAD).
Активизация слоя при выделенном объекте приводит к перемещению этого объекта на активизируемый слой. Поскольку теперь выделенный сегмент находится на слое с номером группы пересечения 1, а остальные сегменты – на слое с номером 2, сопряжение этих сегментов стало невозможным (рис. 7.9, б).
а
б
Рис. 7.9. Работа механизма групп пересечения
8. Замените номер группы пересечения слоя Стены на 1 – сопряжение восстановится, хотя перемещенный сегмент находится на другом слое.
9. Верните сегмент на слой Стены.
ПРИМЕЧАНИЕ
Для иллюстрации отмены действия механизма сопряжения можно было использовать самый простой способ – присвоить слою Стены номер группы пересечения, равный 0.
Теперь вы понимаете принцип работы групп пересечения и можете использовать его в своих целях.
Самостоятельно изучите механизм сортировки и упорядочивания слоев с помощью поля Extension (Расширение).
Меню работы со слоями
Для работы со слоями в ArchiCAD предназначено меню (рис. 7.10), которое вызывается командой Document ► Layers (Документ ► Слои).
Данное меню состоит из двух областей. В нижней области расположен список комбинаций слоев, что позволяет активизировать необходимую комбинацию без вызова окна настройки параметров слоев.
В верхней области меню находятся три пункта:
□ Layer Settings (Настройки слоя) – открывает окно настройки параметров слоев;
□ Show All Layers (Показать все слои) – устанавливает атрибут видимости одновременно для всех слоев;
□ Layer Extras (Атрибуты слоя) – вызывает меню дополнительных параметров, управляющих атрибутами слоев (рис. 7.11), которое включает следующие команды:
Рис. 7.10. Меню для работы со слоями
Рис. 7.11. Меню установки атрибутов слоев
■ Show / Hide Toggle (Показать / Скрыть) – переключает атрибут видимости для всех слоев активной комбинации, видимые слои становятся невидимыми и наоборот;
■ Lock / Unlock Toggle (Блокировать / Разблокировать) – переключает атрибут блокирования, блокированные слои активной комбинации становятся доступными для редактирования, а доступные блокируются;
■ Hide Selections (Скрыть выбранное) – снимает атрибут видимости со слоя, на котором находятся выделенные объекты, при отсутствии выделения данная команда недоступна;
■ Lock Selections (Блокировать выбранное) – блокирует слой, на котором находятся выделенные объекты, при отсутствии выделения данная команда недоступна;
■ Unlock Selections (Разблокировать выбранное) – разблокирует слой, на котором находятся выделенные объекты, при отсутствии выделения данная команда недоступна;
■ Hide Others (Скрыть остальное) – если в проекте выбраны какие-либо объекты, то эта команда делает невидимыми слои, к которым не принадлежат выделенные объекты, при отсутствии выделенных объектов команда заменяется параметром Hide All (Скрыть все слои);
■ Lock Others (Блокировать остальное) – команда подобна предыдущей, но вместо установки атрибута невидимости блокирует слои, на которых нет выбранных объектов, при отсутствии выделенных объектов команда заменяется параметром Lock All (Блокировать все слои);
Undo Layer Change (Отменить действие) – отменяет до восьми последних выполненных действий со слоями; Redo Layer Change (Восстановить действие) – повторяет исполнение до восьми последних выполненных действий со слоями.
Кнопки управления, которые соответствуют рассмотренным командам меню, можно найти на палитре Quick Layers (Атрибуты слоев) (рис. 7.12), которая активизируется командой Window ► Palettes ► Quick Layers (Окно ► Палитры ► Атрибуты слоев).
Рис. 7.12. Палитра инструментов работы с атрибутами слоев
Отдельно расположена команда Active Layer (Активный уровень). При выборе этой команды открывается окно с кнопками One Active Layer for all Element types (Общий слой для элементов всех типов) и Individually set Layers (Индивидуальная установка слоев). Нажатие первой кнопки связывает объекты всех типов с текущим активным слоем. До тех пор пока окно не закрыто, пользователь может вернуться к прежнему состоянию установок атрибутов слоев, для чего необходимо нажать ставшую активной вторую кнопку.
Если окно все-таки было закрыто, то появляется сообщение Do you wish to revert to the last used individually set layers? (Хотите вернуться к последней использованной установке параметров слоев?). Продолжить выполнение действия или отказаться от него помогут расположенные в окне сообщения кнопки Keep Current Level (Использовать текущий слой) и Revert (Вернуться).
После применения действия Active Layer (Активный уровень) автоматически восстановить прежние связи объектов со слоями нельзя, но для каждого объекта можно вновь определить связь с необходимым слоем, используя действия работы со слоями и комбинациями слоев.
В этой главе были рассмотрены слои – один из самых интересных механизмов ArchiCAD, применение которого обеспечивает гибкость визуального представления объектов и снижение вероятности непреднамеренного изменения завершенных частей проекта, что позволяет качественно улучшить процесс проектирования.
Глава 8
Оформление чертежа
Разработка проекта завершается выпуском проектной документации, основу которой составляют чертежи, оформленные в соответствии с принятыми стандартами. Оформление чертежа – сложная и ответственная работа, от выполнения которой зависит сама возможность воплощения разработанного проекта в жизнь. Для облегчения работы по оформлению чертежей ArchiCAD предоставляет пользователю необходимый инструментарий, элементы которого будут рассмотрены в этой главе.
Нанесение размеров – одна из наиболее трудоемких работ процесса оформления чертежей. Рассмотрим имеющиеся в ArchiCAD инструменты, облегчающие работу пользователя по нанесению линейных, угловых, радиальных размеров, созданию выносных надписей, а также отметок высоты и уровней.
Нанесение линейных размеров
Инструмент Dimension (Размер), расположенный в разделе Document (Документ) палитры инструментов и предназначенный для простановки линейных размеров, вызывается нажатием кнопки
Информационная палитра при активизации этого инструмента имеет следующий вид (рис. 8.1).
Рис. 8.1. Параметры построения линейных размеров
Окно настройки параметров линейных размеров (рис. 8.2) вызывается нажатием кнопки
Рис. 8.2. Окно настройки параметров линейных размеров
Настройка параметров линейных размеров
В разделах Type and Font (Тип и шрифт), Marker and Witness Line Options (Параметры маркеров и выносных линий) и Dimension Details (Детали размеров) данного окна расположены элементы управления параметрами линейных размеров.
Вид размерных элементов (верхний подраздел) и размерной надписи (нижний подраздел) определяется в разделе Type and Font (Тип и шрифт) с помощью следующих элементов управления.
□ Переключатель Dimension Type (Тип размерных элементов) – определяет варианты размерных цепей, его можно установить в следующие четыре положения:
– Linear Method (Линейная размерная цепь) – размер указывается между выносными линиями, там же располагается размерная надпись, при недостаточном расстоянии между выносными линиями для размещения размерной надписи она выносится на свободное место, размерная линия с двух сторон помечается маркерами;
– Cumulative Method (Размерная цепь с общей базой) – размер, размещаемый между выносными линиями рядом с маркером, рассчитывается от общей точки (базы), помечаемой на чертеже точкой;
– Base-line Method (Размерная цепь с базовой линией) – отличается от предыдущей только видом, базовая точка не отображается, размерная линия не сплошная;
– Elevation Dimension (Отметка высоты) – будет описана чуть ниже.
□ Кнопка
расположенная справа от переключателя Dimension Type (Тип размерных элементов), предназначена для выбора вида маркеров на концах размерной линии. Имеет различный вид в зависимости от текущего вида маркера. Нажатие кнопки вызывает набор видов маркеров (рис. 8.3), из которых пользователь может выбрать необходимый.
Рис. 8.3. Виды маркеров размерных линий
□ Флажок Static Dimension (Статичный размер) – при установке флажка значение размерной надписи не меняется при изменении размера объекта. При снятом флажке изменение размера объекта приводит к автоматическому пересчету значения размерной надписи.
□ Переключатель Witness Line (Выносная линия) – определяет вид выносной линии. Его можно установить в четыре положения:
– None (Нет) – выносные линии отсутствуют, отображается только размерная линия с маркерами, высота которых устанавливается в поле Marker Size (Размер маркера) раздела Marker and Witness Line Options (Параметры маркеров и выносных линий);
– Sized Height (Фиксированная высота) – выносные линии имеют фиксированную высоту, пропорциональную размеру маркера;
– Custom Height (Заданная высота) – размер выносных линий определяется значением поля Custom Witness Line Length (Заданная длина выносной линии) раздела Marker and Witness Line Options (Параметры маркеров и выносных линий);
– Dinamic Height (Изменяющаяся высота) – выносные линии могут иметь разный размер, причем при изменении положения размерной линии длина выносных линий изменяется динамически; расстояние выносных линий от точек, указанных при создании размера, определяется значением поля Dynamic Witness Line Gap (Зазор динамических выносных линий) раздела Marker and Witness Line Options (Параметры маркеров и выносных линий).
□ Открывающийся список Font Type (Тип шрифта) – предназначен для выбора шрифта размерной надписи.
□ Открывающийся список Font Script (Кодировка) – обеспечивает выбор необходимой кодировки, рекомендуемая кодировка – Cyrillic (Кириллица).
□ Поле Font Height (Высота шрифта) – сюда заносится значение высоты шрифта размерной надписи.
□ Флажки Bold (Полужирный), Italic (Курсив) и Underline (Подчеркнутый) – предназначены для установки начертания шрифта размерной надписи.
□ Переключатель Text Position (Размещение текста) – его можно установить в три положения, соответствующие размещению текста размерной надписи над размерной линией, в разрыве размерной линии и под ней.
В правой части раздела Type and Font (Тип и шрифт) расположены элементы управления выбором перьев для отрисовки маркеров, выносных и размерных линий, а также размерной надписи.
В разделе Dimension Details (Детали размеров) расположены два флажка.
□ Display the Heigh of Openings as well (Показывать высоту проемов) – предназначен для показа в размерной надписи высоты проемов, в частности дверных и оконных, совместно с измеренной шириной проема. Установка флажка делает доступным переключатель, который можно установить в три положения:
■ Always with Oversize (По габариту) – в качестве дополнительного размера отображается габаритная высота проема;
■ Always without Oversize (Без габарита) – в качестве дополнительного размера отображается номинальная высота объекта; Determined by Width (По измерению) – если ширина объекта измерена по габариту ширины, то будет показана габаритная высота, в противном случае будет показана высота объекта.
□ Dimension only the Core of Composite Walls (Размеры несущей части составных стен) – при установке флажка будет указываться только толщина несущей части композитных стен или колонн, а не общая толщина.
Построение линейных размеров
Существует четыре метода построения линейных размеров, каждому из которых соответствует кнопка информационной палитры:
– вертикальный размер. Размерная линия при выборе этого способа будет расположена вертикально;
– горизонтальный размер. Размерная линия при выборе этого способа будет расположена горизонтально;
– наклонный размер. Размерная линия будет построена параллельно имеющейся или воображаемой линии между точками привязки, определенными первыми двумя щелчками кнопки мыши при построении размера;
– размер дуги. Предназначен для отображения линейного размера дугообразных объектов.
Рассмотрим процесс построения линейных размеров, выполнив такую последовательность действий.
1. Постройте контур из стен в виде правильного пятиугольника с горизонтально расположенным основанием.
2. Скруглите углы, прилегающие к основанию контура.
3. Активизируйте инструмент нанесения линейных размеров.
4. Откройте окно настройки параметров размеров по умолчанию.
5. Установите переключатель Dimension Type (Тип размерных элементов) в положение
6. Установите переключатель Witness Line (Выносная линия) в положение
7. Введите в поле Dynamic Witness Line Gap (Зазор динамических выносных линий) раздела Marker and Witness Line Options (Параметры маркеров и выносных линий) значение 0.
8. Закройте окно настройки параметров размеров по умолчанию, нажав кнопку OK.
Построим размерную цепь, определяющую длину проекций верхних сегментов пятиугольника на ось X. Для этого необходимо выполнить следующие действия.
1. Выберите метод построения горизонтального размера кнопкой
2. Последовательно щелкните кнопкой мыши слева направо на нескругленных вершинах пятиугольника.
3. Дважды щелкните кнопкой мыши на свободном поле чертежа или нажмите клавишу Delete – указатель мыши должен принять форму
4. Поместите указатель мыши над верхней вершиной пятиугольника и щелкните кнопкой мыши – горизонтальный размер будет построен (рис. 8.4, а).
Построим размерную цепь с общей базой, определяющую высоту пятиугольника, выполнив следующие действия (последнее значение размерной надписи даст общую высоту пятиугольника).
1. Нажмите кнопку
2. Кнопкой
выберите построение вертикального размера.
3. Нажав кнопку
откройте набор видов маркеров и выберите изображение маркера в виде стрелки.
4. Последовательно щелкните кнопкой мыши снизу вверх на крайней точке основания, правой вершине пятиугольника и его верхнем углу.
5. Поместите указатель мыши с правой стороны нашего пятиугольника и щелкните кнопкой мыши – вертикальный размер будет построен (рис. 8.4, б).
ПРИМЕЧАНИЕ
Размерные надписи и размерные линии можно перемещать, перетаскивая их мышью. Для этого необходимо предварительно выделить перетаскиваемый объект.
Построим наклонный размер и размер дуги, снова изменив вари ант размерной цепи, для чего необходимо выполнить следующие действия.
1. Щелкните мышью на кнопке
2. Выберите метод построения наклонного размера с помощью кнопки
3. Щелкните кнопкой мыши на левой вершине пятиугольника.
4. Щелкните кнопкой мыши на точке сопряжения левого сегмента с дугой.
5. Дважды щелкните кнопкой мыши на свободном поле чертежа или нажмите клавишу Delete – указатель мыши должен принять форму
6. Укажите положение размерной линии – наклонный размер будет построен.
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Рис. 8.4. Построение ортогональных размеров
7. Кнопкой
выберите метод построения размера дуги.
8. Щелкните кнопкой мыши на ребре дугового сегмента, сопрягающего данную сторону пятиугольника с его основанием.
9. Дважды щелкните кнопкой мыши на свободном поле чертежа или нажмите клавишу Delete.
10. Укажите положение размерной линии – размер дуги будет построен (рис. 8.5).
Рис. 8.5. Построение наклонного размера и размера дуги
Нанесение радиальных размеров
Кнопка инструмента построения радиальных размеров Radial Dimension (Радиальный размер)
по умолчанию отсутствует на палитре инструментов. Вызвать этот инструмент можно командой главного меню Document ► Documenting Tools ► Radial Dimension (Документ ► Инструменты оформления ► Радиальный размер). На информационной палитре отобразятся элементы управления настройкой параметров радиальных размеров (рис. 8.6).
Для вызова диалогового окна настройки параметров радиальных размеров (рис. 8.7) предназначена кнопка
информационной палитры.
Рис. 8.6. Информационная палитра в режиме построения радиальных размеров
Рис. 8.7. Окно настройки параметров радиальных размеров
Настройка параметров радиальных размеров
Окно настройки параметров радиальных размеров включает в себя всего один раздел Type and Font (Тип и шрифт). Из ранее не рассмотренных элементов управления в данном разделе имеется всего три:
□ переключатель Dimension Type (Тип размерных элементов) – определяет наличие маркера в центре образмериваемой дуги или окружности;
□ переключатель Pointer Line & Text (Размерная линия и текст) – три положения, в которые можно установить данный переключатель, определяют вид размерной линии и расположение текста относительно ее;
□ текстовое поле Prefix (Префикс) – здесь указывается произвольная информация, которая будет помещена перед размерной надписью. Обычно это знак радиуса R.
Остальные параметры раздела Type and Font (Тип и шрифт) были описаны в предыдущем разделе.
Построение радиальных размеров
Построим радиальный размер правого сопряжения, выполнив следующие действия.
1. Вызовите инструмент построения радиальных размеров командой меню Document ► Documenting Tools ► Radial Dimension (Документ ► Инструменты оформления ► Радиальный размер).
СОВЕТ
При необходимости постоянной работы с радиальными размерами поместите кнопку Radial Dimension (Радиальный размер)
в раздел Document (Документ) палитры инструментов, вызвав окно настройки палитры с помощью команды Options ► Work Environment ► Toolbox (Параметры ► Рабочая среда ► Инструменты).
2. Выберите построение радиального размера без отрисовки маркера центра, нажав кнопку
информационной палитры.
3. Нажав кнопку
информационной палитры, выберите положение размерной надписи над горизонтальной выносной линией.
4. Щелкните кнопкой мыши на внешнем ребре дуги сопряжения – из точки щелчка будет отрисована линия радиального размера.
5. Переместите указатель мыши за пределы пятиугольника в точку предполагаемого размещения выносной линии.
6. Щелкните кнопкой мыши – радиальный размер с указанными параметрами будет построен (рис. 8.8).
Элементы радиального размера можно редактировать, используя функции палитры редактирования, которая появляется при щелчке кнопкой мыши на узловых точках выносной линии радиального размера.
Нанесение угловых размеров
Для нанесения угловых размеров предназначен инструмент Angle Dimension (Угловой размер). Кнопка этого инструмента
как и кнопка инструмента построения радиальных размеров, по умолчанию отсутствует на палитре инструментов. Вызвать этот инструмент можно командой главного меню ArchiCAD Document ► Documenting Tools ► Angle Dimension (Документ ► Инструменты оформления ► Угловой размер).
Рис. 8.8. Построенный радиальный размер
СОВЕТ
При необходимости постоянной работы с угловыми размерами поместите кнопку Angle Dimension (Угловой размер)
в раздел Document (Документ) палитры инструментов, вызвав окно настройки палитры с помощью команды Options ► Work Environment ► Toolbox (Параметры ► Рабочая среда ► Инструменты).
После щелчка кнопкой мыши на этом инструменте на информационной палитре появляются элементы управления, предназначенные для настройки параметров элементов угловых размеров (рис. 8.9).
Рис. 8.9. Элементы управления настройкой угловых размеров
Нажатием кнопки
вызывается окно настройки параметров угловых размеров (рис. 8.10).
Рис. 8.10. Окно настройки параметров угловых размеров
Настройка параметров угловых размеров
Большинство элементов управления данного окна не изменились. Поменялись положения переключателя Dimension Type (Тип размерных элементов): Inner Dimension (Внутренний размер) и Outer Dimension (Внешний размер), определяющие положение размерной линии внутри измеряемого угла или снаружи.
Кроме того, появился новый переключатель Number Orientation (Ориентация размерной надписи), который можно установить в три положения: Horizontal (Горизонтально), Perpendicular (Перпендикулярно) и Parallel (Параллельно). При установке переключателя в первое положение раз мерная надпись размещается горизонтально, во второе – по биссектрисе угла, в третье – вдоль размерной линии.
Построение угловых размеров
Для построения угловых размеров необходимо выполнить следующие действия.
1. Активизировать инструмент построения угловых размеров, нажав кнопку
Angle Dimension (Угловой размер) или выполнив команду Document ► Documenting Tools ► Angle Dimension (Документ ► Инструменты оформления ► Угловой размер).
2. Настроить параметры размера, используя элементы управления, расположенные на информационной палитре или в окне настройки параметров угловых размеров по умолчанию.
3. Выбрать объект(ы) для измерения, учитывая, что для каждого измеряемого объекта существуют свои следующие способы выбора:
■ для измерения угла дуги необходимо щелкнуть кнопкой мыши на измеряемой дуге, ребре или базовой линии дугообразного измеряемого объекта;
■ для измерения угла между двумя прямолинейными объектами нужно щелкнуть кнопкой мыши сначала на одном, затем на другом объекте;
■ для измерения угла между произвольно выбранными точками двумя щелчками кнопкой мыши нужно определить направление первого вектора, следующими двумя щелчками – направление второго вектора, угол будет измерен между двумя этими векторами.
По завершении выбора измеряемых объектов указатель мыши примет форму
4. Щелчком кнопки мыши определить положение размерной линии – размер будет построен в соответствии с настроенными параметрами.
В зависимости от того, в какое положение установлен переключатель Dimension Туре (Тип размерных элементов), и положения размерной линии возможны варианты построения углового размера.
Рассмотрим следующие комбинации указанных параметров.
Переключатель Dimension Туре (Тип размерных элементов) установлен в положение Inner Dimension (Внутренний размер):
□ положение размерной линии указано внутри измеряемого угла – измеряется внутренний угол (рис. 8.11, а);
□ положение размерной линии указано снаружи измеряемого угла – строится центральный угол, размер ставится внутри его (рис. 8.11, б).
Переключатель Dimension Туре (Тип размерных элементов) установлен в положение Outer Dimension (Внешний размер):
□ положение размерной линии указано снаружи измеряемого угла – из меряется внешний угол (рис. 8.12, а);
□ положение размерной линии указано внутри измеряемого угла – строится центральный угол, размер при этом ставится снаружи него (рис. 8.12, б).
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Рис. 8.11. Построение внутренних угловых размеров
а
б
Рис. 8.12. Построение наружных угловых размеров
Угловой размер дуги строится одинаково независимо от положения переключателя Dimension Type (Тип размерных элементов).
Нанесение отметок возвышений на разрезы/фасады
Инструмент построения отметок возвышений (уровней) на разрезах/фасадах (кнопка
находится в составе окна настройки параметров линейных размеров. При активизации данного инструмента окно настройки параметров линейных размеров изменяется (рис. 8.13).
Рис. 8.13. Режим настройки параметров отметок возвышений
В списке стандартных уровней помимо нулевого уровня проекта и двух базовых уровней, определяемых пользователем, можно выбрать возвышение относительно пользовательской системы координат. Такая возможность доступна, если положение точки отсчета стандартной системы координат изменено пользователем.
Элементы, предназначенные для управления видом маркера (рис. 8.14) расположены в два ряда.
Рис. 8.14. Элементы управления видом маркера отметок возвышений
С помощью кнопок первого ряда выбирается общий вид маркера. Выбранный вариант уточняется с помощью трех переключателей, расположенных во втором ряду. Первый переключатель определяет размещение значка маркера относительно линии возвышения – сверху или снизу. Вторым переключателем уточняется форма значка маркера. Третий переключатель определяет наличие закраски значка.
При выборе изображения маркера в виде значка отметки уровня на плане этажа – окружности, разделенной на четыре сектора, нижний ряд элементов управления изменяется (рис. 8.15).
Рис. 8.15. Варианты вида маркера возвышения на плане этажа
Первый переключатель определяет положение размерного текста относительно значка маркера, второй – вариант закраски.
Переключатель, определяющий наличие знака перед значением уровня, можно установить в два положения. При установке в первое положение знак + (плюс) при положительном возвышении не отображается, при установке во второе – данный знак отображается. При отрицательном возвышении знак – (минус) ставится вне зависимости от положения этого переключателя.
Активизация инструмента построения отметок возвышений изменяет и вид информационной палитры (рис. 8.16).
Рис. 8.16. Информационная палитра при активизации инструмента отметок возвышений
На информационной палитре становятся доступными рассмотренные выше элементы настройки параметров отметок возвышений.
Построение отметок возвышений на разрезах / фасадах
Отметки возвышений на разрезах / фасадах строятся точно так же, как и при построении линейных размерных цепей. Для этого необходимо выполнить следующие действия.
1. Спроектируйте двухэтажный дом, который похож на показанный на рис. 8.17.
2. Перейдите в окно фасадов, дважды щелкнув кнопкой мыши на одном из элементов списка Elevations (Фасады) окна навигатора.
Рис. 8.17. Пример для построения отметок возвышений
3. Активизируйте инструмент построения отметок возвышений.
4. Последовательно щелкните кнопкой мыши на точках, возвышения которых необходимо построить. Указанные точки будут помечены маркерами, представляющими собой круг с осевыми линиями.
ПРИМЕЧАНИЕ
При щелчке кнопкой мыши на свободном поле чертежа маркеры будут иметь вид квадратов с осевыми линиями.
5. После указания последней точки дважды щелкните кнопкой мыши на свободном поле чертежа или нажмите клавишу Delete – указатель мыши примет форму молотка (рис. 8.18, а).
6. В точке предполагаемого размещения отметок щелкните кнопкой мыши. При этом указанные отметки возвышений будут построены (рис. 8.18, б).
Если отметки возвышений построены в процессе выполнения одного действия, то при выделении любой из отметок выделяется вся цепь, поэтому при попытке отредактировать, какой-либо параметр изменение отразится на всей цепи возвышений.
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Рис. 8.18. Построение отметок возвышений на разрезах / фасадах
Нанесение отметок возвышений на план этажа
Для отображения отметок возвышений на планах этажей в ArchiCAD имеется отдельный инструмент, вызываемый нажатием кнопки
Level Dimension (Отметки уровня) палитры инструментов. При его активизации на информационной палитре появляются соответствующие элементы управления (рис. 8.19).
Рис. 8.19. Параметры отметок возвышений на плане этажа
Нажатие кнопки
открывает окно настройки параметров данного инструмента (рис. 8.20).
Рис. 8.20. Окно настройки параметров отметок возвышений
Настройка параметров отметок возвышений на плане этажа
По сравнению с ранее рассмотренными инструментами в данном окне изменено содержимое набора видов маркера, появилось поле установки угла поворота маркера и флажок Label Frame (Рамка отметки), установка которого обрамляет рамкой значение возвышения.
Отметки возвышений на плане этажа должны быть привязаны к одному из объектов. Объекты привязки выбираются нажатием кнопки Gravity (Притяжение)
расположенной на палитре Coordinates (Координаты), которую можно вызвать командой Window ► Palettes ► Coordinates (Окно ► Палитры ► Координаты).
ПРИМЕЧАНИЕ
Кнопка выбора способа привязки будет доступна только при активном инструменте Level Dimension (Отметки уровня) или режимах построения стен, колонн, балок или вставке библиотечных объектов. Вид кнопки меняется в зависимости от установленного способа привязки.
Отметки возвышений на плане этажа могут быть привязаны к следующим объектам проекта:
– без привязки. Привязка осуществляется к уровню текущего этажа;
– к перекрытию;
– к скату крыши;
– к 3D-сетке.
Поскольку разные точки двух последних объектов могут иметь разные возвышения, привязка будет осуществляться к точке, на которой произведен щелчок кнопкой мыши при указании отметки возвышения.
Построение отметок возвышений на плане этажа
Для построения отметки возвышения необходимо выполнить следующие действия.
1. Активизировать инструмент Level Dimension (Отметки уровня).
2. Настроить параметры отметки возвышения.
3. Выбрать уровень отсчета и способ привязки точки возвышения к объекту проекта.
4. Выполнить щелчок кнопкой мыши на необходимой точке плана этажа (рис. 8.21).
Выносные надписи
Выносные надписи используются для нанесения на чертежи дополни тельной информации, которая может быть текстовой, графической или совместной. Для создания выносных надписей в ArchiCAD предназначен инструмент Label (Выносная надпись), кнопка активации которого
находится в разделе Document (Документ) палитры инструментов.
Рис. 8.21. Построение отметок возвышений на плане этажа
Нажатие этой кнопки открывает элементы управления настройками параметров выносных надписей на информационной палитре (рис. 8.22).
Рис. 8.22. Элементы управления настройкой параметров выносных надписей
С помощью кнопки
открывается окно настройки параметров выносных надписей (рис. 8.23).
Элементы управления настройками параметров выносных надписей сгруппированы в следующих шести разделах:
□ Content and Preview (Содержание и просмотр);
□ Text Style (Стиль текста);
□ Pointer (Линия выносной надписи);
□ Symbol Label (Символ выносной надписи);
□ Custom Settings (Специальные параметры);
□ Text Label (Текст выносной надписи).
Рис. 8.23. Окно настройки параметров выносных надписей
Разделы Text Style (Стиль текста) и Custom Settings (Специальные параметры) рассматривать не будем, так как все параметры первого из них уже вам знакомы, а второй недоступен, поскольку в стандартной поставке ArchiCAD нет символов выносной надписи, параметры которых устанавливаются в этом разделе.
В разделе Content and Preview (Содержание и просмотр) расположены три элемента управления.
□ Список объектов ArchiCAD, с которыми могут быть связаны выносные надписи. С каждым из объектов можно связать выносную надпись, которая будет появляться на плане этажа при щелчке кнопкой мыши на этом объекте при активном инструменте создания выносных надписей. Кроме стандартных объектов ArchiCAD в списке присутствует объект Independent Label (Независимая выносная надпись), которая не привязана ни к одному из объектов.
□ Кнопка Text (Текст), открывающая меню стандартных выносных надписей.
□ Поле предварительного просмотра, в котором отображается выносная надпись, представляющая библиотечный объект, если он имеет графическое представление для показа в этом поле.
В разделе Pointer (Линия выносной надписи) (рис. 8.24) можно настроить вид линии и маркера, точку привязки линии к текстовому блоку, размер маркера, а также выбрать перья для отображения линии выносной надписи и ее маркера.
Рис. 8.24. Элементы управления линией выносной надписи
Раздел Symbol Label (Символ выносной надписи) доступен при выборе в качестве выносной надписи библиотечного объекта и содержит элементы управления настройкой его параметров. Вид и количество параметров зависят от конкретного объекта.
Раздел Text Label (Текст выносной надписи) становится доступным при выборе в качестве выносной надписи объекта Text (Текст) (рис. 8.25).
Рис. 8.25. Элементы управления раздела Text Label (Текст выносной надписи)
Поле Default Text (Текст по умолчанию) предназначено для ввода текста выносной надписи. Переключатель Label Orientation (Ориентация выносной надписи) можно установить в четыре положения, причем для независимой выносной надписи доступно только последнее, определяющее угол наклона выносной надписи, который вводится в текстовом поле Set Custom Angle (Произвольный угол наклона). Установка флажка Fix Angle (Блокировать угол) защищает значение введенного угла от случайных изменений.
При выборе выносной надписи, связанной с объектом, доступны еще три положения переключателя Label Orientation (Ориентация выносной надписи). Верхняя ориентирует надпись в соответствии с углом наклона объекта, следующие две – вертикально и горизонтально.
Построение выносных надписей
Рассмотрим построение независимых выносных надписей, поскольку это наиболее гибкий и часто применяемый способ. Независимые выносные надписи не имеют ограничений по количеству размещений. В качестве независимой выносной надписи могут быть использованы любые объекты, доступные в меню объектов выносных надписей. Если для независимой надписи выбран объект Text (Текст) и поле Default Text (Текст по умолчанию) раздела Text Label (Текст выносной надписи) пусто, то необходимый текст будет запрошен в процессе построения надписи. Это позволяет строить выносные надписи с произвольным текстом, для чего необходимо выполнить следующие действия.
1. Активировать инструмент построения выносных надписей.
2. Нажатием кнопки
открыть окно настройки параметров выносных надписей.
3. Щелкнуть кнопкой мыши на объекте Independent Label (Независимая выносная надпись) в списке объектов раздела Content and Preview (Содержание и просмотр).
4. Нажать кнопку, расположенную справа от списка объектов, и из появившегося меню выбрать элемент Text (Текст).
5. Установить кодировку Cyrillic (Кириллица) в разделе Text Style (Стиль текста).
6. Настроить необходимые параметры текста.
7. Убедиться, что поле Default Text (Текст по умолчанию) раздела Text Label (Текст выносной надписи) пусто.
8. Нажать кнопку OK, чтобы закрыть окно настройки параметров выносной надписи.
Теперь по умолчанию при выборе Label (Выносная надпись) будет активизироваться выносная надпись с заданными параметрами.
Построим надпись, выполнив следующие действия.
1. Если кнопка информационной палитры, расположенная справа от кнопки выбора слоя, имеет вид
то нажмите ее и выберите режим построения независимой надписи, использовав кнопку
2. Щелкните кнопкой мыши на точке, где должен находиться маркер выносной надписи (начало линии).
3. Вторым щелчком кнопкой мыши определите конец линии.
4. Если необходимо продолжить выносную линию горизонтальной полкой или построить дугообразную выносную линию, то переместите указатель мыши в конечную точку полки или дуги.
ПРИМЕЧАНИЕ
Для построения дугообразной выносной линии необходимо установить в соответствующее положение переключатель вида выносной линии в разделе Pointer (Линия выносной надписи).
5. Щелкните кнопкой мыши – определенная конечная точка выносной линии является начальной точкой текстового блока.
6. Если необходимо задать конкретную ширину текстового блока, то переместите указатель мыши на необходимое расстояние.
7. Щелкните кнопкой мыши – активизируется окно текстового редактора с панелью форматирования текста.
8. Введите необходимый текст.
9. Щелкните кнопкой мыши – независимая выносная надпись будет построена.
Редактирование выносных надписей
Редактируются выносные надписи после их выделения обычным способом. Выносные надписи можно перемещать, копировать, зеркально отражать, изменять положение их характеристических точек, а также другие параметры.
В данной главе были рассмотрены возможности ArchiCAD, предназначенные для оформления чертежа.
Материал главы дает представление об инструментах построения размеров и выносных надписей, настройке их параметров. Также из главы можно получить практические навыки образмеривания и описания элементов проекта на чертежах.
Глава 9
Визуализация элементов проекта: двумерные изображения
В данной главе представлены принципы и процессы создания плоских изображений, строящихся по виртуальной трехмерной модели и предназначенные для визуализации проекта. Рассмотрим создание деталировочных чертежей, рабочих листов и вставку изображений.
Деталировочные чертежи
При построении виртуальной модели нет смысла скрупулезно соблюдать все подробности архитектуры проекта, например вырисовывать в необходимых местах гвозди или шурупы. Но при разработке документации часто приходится указывать такие подробности, которые не нужны для построения виртуальной модели здания, но необходимы для его возведения. При ручном проектировании или использовании универсальных САПР подобные объекты выносятся в отдельные виды на листы чертежей с соответствующими примечаниями. Возможность получения подобных видов есть и в ArchiCAD.
Принцип создания деталировочных чертежей заключается в том, что в определенном месте на плане этажа или виде разреза помещается маркер, связанный с отдельным листом чертежа. На этом листе пользователь может создать любое изображение, используя инструменты построения двумерных графических элементов, простановки размеров и создания текстовых блоков, создания выносных надписей, вставки рисунков и других чертежей, а также инструменты вставки двумерных библиотечных элементов ArchiCAD.
Настройка параметров деталировочных чертежей
Инструмент создания деталировочных чертежей вызывается кнопкой Detail (Деталь)
палитры инструментов. Элементы управления настройкой его параметров появляются на информационной палитре (рис. 9.1).
Рис. 9.1. Информационная палитра в режиме деталировочных чертежей
Нажатие кнопки
открывает окно настройки параметров деталировочного чертежа (рис. 9.2).
Рис. 9.2. Окно настройки параметров деталировочного чертежа
Поскольку деталировочный чертеж создается по плоскому изображению, в разделе General (Общие настройки) нет элементов управления глубиной просмотра и глубиной вида. Имеется флажок Copy construction elements only (Копировать только конструкционные элементы). При его установке на создаваемый вид будут перенесены только элементы изображения плана этажа без элементов оформления, то есть текстовые блоки, размеры и выноски включены в созданный вид не будут.
ПРИМЕЧАНИЕ
Все выше сказанное относится к деталировочному чертежу, создаваемому по виртуальной модели проекта – плану этажа, то есть с выбором элемента Create new detail viewpoint (Создать новую деталировку) из открывающегося списка раздела General (Общие настройки) окна настройки параметров.
В разделе Marker (Маркер) имеется переключатель Marker Angle (Угол поворота маркера), с помощью которого можно установить угол поворота маркера деталировочного чертежа относительно системы координат проекта.
Построение деталировочных чертежей
Для построения деталировочных чертежей необходимо выполнить следующие действия.
1. Активировать необходимое окно – это может быть окно плана этажа или другого плоского вида: разреза, фасада, интерьера, другого деталировочного чертежа и т. п.
2. Активизировать инструмент построения деталировочных чертежей.
3. Настроить параметры деталировочного чертежа.
4. Выбрать метод построения области выносимого вида с помощью следующих кнопок информационной палитры:
No boundary (Без границ) – область детализации не имеет визуальных границ, отображается только маркер деталировочного чертежа;
Polygonal (Полигон) – область детализации имеет произвольную форму, которую можно нарисовать, используя инструмент построения полилинии, эта область должна быть замкнута;
Rectangular (Прямоугольник) – область детализации имеет прямоугольную форму;
Rotated Rectangular (Повернутый прямоугольник) – область детализации имеет форму прямоугольника, повернутого на определяемый в процессе построения угол.
5. Определить форму области детализации. Для метода No boundary (Без границ) достаточно щелкнуть кнопкой мыши на необходимом месте окна.
6. Определить положение маркера деталировочного чертежа, щелкнув кнопкой мыши на нужном месте рабочего поля.
После выполнения указанных действий в разделе Details (Деталировочные чертежи) палитры навигатора появляется связанный с маркером элемент, имеющий название, состоящее из введенных в полях Reference ID (Идентификатор) и Name (Наименование) строк, а на экране открывается окно с элементами, содержавшимися в области детализации.
ПРИМЕЧАНИЕ
Если область детализации не определена или построена на пустом пространстве, то окно деталировочного чертежа будет пустым.
Элементы, перенесенные в окно деталировочного чертежа из области детализации, перестают быть конструктивными объектами. Они становятся просто набором плоских графических примитивов, которые можно редактировать стандартными инструментами ArchiCAD.
Рассмотрим пример использования механизма создания деталировочного чертежа.
Для показа вида лестницы сбоку был построен разрез (рис. 9.3, а). Область примыкания лестничного пролета к лестничной площадке показана на виде разреза размещением маркера деталировочного чертежа. Граница области детализации построена методом Polygonal (Полигон) в виде окружности (рис. 9.3, б).
Автоматически созданный системой ArchiCAD по виду разреза деталировочный чертеж был лишен подробной информации. Вместо него с помощью инструментов создания двумерных объектов, в частности линий, дуг, окружностей, областей штриховок, размерных и выносных элементов, а также текстовых блоков, был построен деталировочный чертеж, содержащий необходимую информацию (рис. 9.4).
Рабочие листы
В ArchiCAD есть инструмент, подобный инструменту создания деталировочных чертежей. Это Worksheet (Рабочий лист), кнопка активации которого
находится на палитре инструментов. Нажатие дан ной кнопки отображает на информационной палитре элементы настройки параметров рабочих листов (рис. 9.5).
Кнопка
открывает окно настройки параметров этого инструмента, который полностью соответствует окну настройки параметров деталировочных чертежей.
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Рис. 9.3. Построение деталировочного чертежа
Отличия инструмента создания рабочих листов от инструмента создания деталировочных чертежей следующие.
□ При создании рабочего чертежа без определения области детализации создается не пустая область, а изображение, включающее в себя все объекты, расположенные на исходном виде. В связи с этим кнопка выбора данного метода построения имеет вид
Рис. 9.4. Деталировочный чертеж
Рис. 9.5. Информационная палитра в режиме построения рабочих листов
□ В создаваемый рабочий чертеж по умолчанию включаются не только конструкционные, но и информационные элементы, такие, как размеры, выноски, блоки текста.
□ Масштаб создаваемого рабочего чертежа соответствует масштабу исходного вида, в отличие от деталировочного чертежа, который имеет масштаб в два раза больший, чем исходный вид.
Во всем остальном эти инструменты идентичны.
Вставка изображений
Инструментарий ArchiCAD, предназначенный для визуализации разрабатываемого проекта, не ограничивается рассмотренными механизмами автоматического или интерактивного создания видов. Часто в проект требуется поместить уже готовые изображения, причем они могут быть созданы в других программах или даже без применения компьютера, например карты местности, фотографии и т. п.
Поместить в проект ArchiCAD различные графические объекты можно с помощью инструментов вставки изображений.
Инструмент вставки изображений активизируется командой главного меню Document ► Documenting Tools ► Figure (Документ ► Инструменты оформления ► Изображение), поскольку по умолчанию кнопка данного инструмента
на палитре инструментов отсутствует. При активации инструмента на информационной палитре появляются элементы управления его параметрами (рис. 9.6).
Рис. 9.6. Элементы управления инструментом вставки изображений
Настройка параметров вставки изображений
Нажатие кнопки
открывает окно настройки параметров вставки изображений (рис. 9.7).
Рис. 9.7. Окно настройки параметров вставки изображений
Для предварительного просмотра и определения местонахождения вставляемого изображения, его имени, размеров, вида и ориентации предназначены элементы управления раздела Preview and Positioning (Просмотр и расположение).
Опишем самые важные элементы управления:
□ кнопка Open (Открыть) – предназначена для выбора файла, содержащего вставляемое изображение, ArchiCAD поддерживает большинство популярных графических форматов (BMP, GIF, JPG, TIF, PSD, PNG, PCT, TGA, SGI);
□ кнопка Paste (Вставить) – позволяет вставить в проект ArchiCAD изображение, находящееся в буфере Windows, если в буфере находится текст, то он перед вставкой растеризуется (переводится в графический формат);
□ текстовые поля Figure Size (Размер изображения) – предназначены для определения размера вставляемого изображения по горизонтали и вертикали;
□ окно Preview (Предварительный просмотр) – здесь отображается вставляемое изображение;
□ поле Picture Name (Имя изображения) – расположено под окном предварительного просмотра и предназначено для присвоения вставляемому изображению наименования для его идентификации в проекте, данное имя никак не связано с именем файла вставляемого изображения;
□ флажок Insert usinf 1 to 1 pixel correspondence with screen resolution (Вставить рисунок в соответствии с текущим масштабом экрана) – позволяет вставить изображение с подгонкой его размеров под разрешение текущего окна, то есть каждый пиксел вставляемого изображения будет соответствовать одному пикселу экрана;
□ флажок Transparent (Прозрачный) – установка флажка приведет к замене белых пикселов вставляемого изображения на пикселы, расположенные на месте вставки, таким образом, станут видимы объекты, расположенные под вставляемым изображением.
В разделе Image Format (Формат изображения) можно настроить формат сохранения изображения в проекте.
Вставка и редактирование изображений
Определив файл вставляемого изображения или содержимое буфера об мена, изображение можно вставить в проект необходимое количество раз, просто последовательно щелкая на нужных местах кнопкой мыши.
Вставляемое изображение помещается под имеющиеся объекты, в отличие от двумерных объектов ArchiCAD, которые при построении располагаются сверху уже имеющихся на плане объектов.
Цели применения изображений могут быть разными. Можно, например, «положить» на пол этажа паркет, «повесить» на стену персидские ковры (рис. 9.8) или «подложить» под основание фундамента карту местности. Все зависит от конкретной задачи и фантазии разработчика.
Рис. 9.8. Вставка рисунка ковра на вид разреза
После выделения вставленное изображение становится обычным плоским объектом ArchiCAD. Кроме изменения его свойств в окне параметров над ним можно выполнять стандартные действия редактирования объектов: перемещение, поворот, зеркальное отражение, тиражирование и изменение размеров.
Данная глава была посвящена визуальному оформлению проекта, она содержит информацию о способах и методах создания дополнительных графических изображений, позволяющих подготовить необходимую информацию для представления проекта.
В главе подробно рассмотрены принципы использования в проекте деталировочных чертежей, позволяющих дополнить построения виртуальной модели технической графикой, а также готовых изображений, кроме того, приведены примеры их использования.
Глава 10
Вывод чертежей на печать
Одна из особенностей ArchiCAD – наличие в проекте не только графи ческой, но и текстовой документации: списков, отчетов, сценариев, описаний объектов, смет и т. п. Поэтому распечатать документацию в ArchiCAD можно в двух вариантах. Во-первых, в любой момент времени можно получить твердую копию имеющегося изображения из любого окна проекта, включая печать текстовой документации. Во-вторых, можно скомпоновать из любых изображений необходимые чертежи установленного стандарта с последующей их распечаткой.
Для вывода информации предназначены две команды: File ► Plot (Файл ► Вывести на плоттер) – для вывода на плоттер и File ► Print (Файл ► Распечатать) – для распечатки на принтере. Рассмотрим эти команды подробнее.
Вывод на плоттер
Команда File ► Plot (Файл ► Вывести на плоттер) открывает окно настройки параметров вывода документа на плоттер (рис. 10.1).
В данном окне расположены следующие элементы управления:
□ информационное поле Plotter (Плоттер) – отображает текущее устройство вывода;
ПРИМЕЧАНИЕ
Устройством может быть и реальный, подключенный к компьютеру или находящийся в локальной сети плоттер с установленным драйвером, и виртуальные устройства, наличие которых зависит от установленных на компьютере программ.
□ кнопка Plot Setup (Настройка вывода) – использование данной кнопки эквивалентно выполнению команды File ► Plot Setup (Файл ►
Настройки вывода), открывающей окно с элементами управления выбором устройства вывода и настройками параметров вывода, зависящими от выбранного плоттера;
□ переключатель Destination (Направление) – позволяет выбрать направление вывода информации;
Рис. 10.1. Окно настройки параметров вывода на плоттер
□ переключатель Scale (Масштаб) – предназначен для управления размерами выводимого изображения;
□ открывающийся список Text & Markers (Текст и маркеры) – доступен при выборе масштаба, не совпадающего с собственным масштабом выводимого документа, в этом случае можно выбрать масштаб отображения текстовой информации и маркеров:
■ Resize to Plotting Scale (Масштабировать) – надписи и маркеры будут масштабированы в соответствии с выбранным масштабом изображения;
■ Fix Size (Не масштабировать) – размеры надписей и маркеров останутся такими, какими они были установлены при создании;
□ флажок Plot Grid (Вывести сетку) – выводит сетку ArchiCAD;
□ флажок Hairline (Тонкие линии) – все линии чертежа будут выведены самыми тонкими линиями, на которые способен выбранный плоттер;
□ открывающийся список Plot with (Цветовая схема) – позволяет управлять цветом печати;
□ поле со счетчиком Copies (Копии) – здесь указывается количество копий выводимого изображения.
Настройка плоттера
Выполнение команды File ► Plot Setup (Файл ► Настройки вывода) или нажатие кнопки Plot Setup (Настройки вывода) окна настройки параметров вывода документа откроет окно настройки параметров плоттера (рис. 10.2).
Рис. 10.2. Элементы управления настройками параметров плоттера
В левом верхнем углу данного окна расположены открывающиеся списки, предназначенные для выбора производителей плоттеров и моделей плоттеров.
Выбрать носитель и расположение на нем выводимого изображения можно с помощью элементов управления, расположенных в области Paper (Бумага). Эти параметры позволяют выбирать поля и формат носителя бумаги. Изменять их обычно не нужно, и выбираемые значения не должны противоречить настройкам, выполненным с помощью панели управления плоттера. Кнопка Revert to factory defaults (Восстановить заводские установки) отменяет внесенные в настройки параметров изменения и возвращает заводские установки.
Вывод на принтер
С помощью команды File ► Print (Файл ► Печать) или комбинации клавиш Ctrl+P открывается окно настройки параметров распечатки документа (рис. 10.3).
Рис. 10.3. Окно настройки параметров печати
В данном окне расположены элементы управления печатью. Смысл их достаточно понятен и при необходимости может быть уточнен в справочной системе программы. Упомянем только некоторые из них:
□ флажок Black and White (Черно-белая печать) – позволяет печатать цветные элементы следующим образом:
■ все цветные линии будут черными, все белые – белыми;
■ все цветные линии штриховки будут черными, все белые линии – белыми, заливка будет отпечатана серым цветом;
■ связанные виды, зоны и рисунки будут распечатаны в градациях серого цвета;
□ флажок Dithering (Размывание) – уменьшает количество выводимых цветов при печати полноцветных изображений;
□ флажок Header / Footer (Заголовок / Подпись) – печать заголовка (подписи) выводимого изображения.
Содержание информации, выводимой в заголовке или подписи изображения, определяется установкой параметров окна Header / Footer (Заголовок / Подпись) (рис. 10.4), которое открывается нажатием в окне настройки параметров распечатки документа кнопки Settings (Настройки), которая становится доступной при установке флажка Header / Footer (Заголовок / Подпись).
Рис. 10.4. Окно Header / Footer (Заголовок / Подпись)
Содержимое строки, выводимой в качестве заголовка или подрисуночной подписи, определяется элементами управления области Content (Содержимое). Их назначение достаточно очевидно из названий, поэтому не будем на этом останавливаться подробно. Пользователь может самостоятельно изучить эту информацию в справочной системе программы.
Настройка принтера
Окно настройки параметров страницы (рис. 10.5) можно вызвать одним из следующих способов:
□ нажать кнопку Page Setup (Настройки страницы) окна настройки параметров печати документа;
□ выполнить команду File ► Page Setup (Файл ► Настройки страницы);
□ нажать комбинацию клавиш Ctrl+Shift+P.
Рис. 10.5. Окно настройки параметров страницы
В данном окне расположен стандартный набор элементов управления печатью. Сделав свои назначения, нажмите кнопку OК и выполните печать на указанном принтере.
Оформление документации
Концепция подготовки документации в ArchiCAD базируется на понятии Layout Book (Книга чертежей). Под этим термином понимается совокупность листов чертежа (Layout), на которых пользователь может размещать виды проекта. Лист чертежа связан с шаблоном (Master) – объектом, определяющим параметры листа. Шаблон может включать графические и текстовые объекты, которые будут отображаться на всех листах, связанных с этим шаблоном. Листы чертежей можно группировать в подмножества (Subset), аналогичные папкам, то есть создавать собственную структуру проектной документации.
Используя эти абстрактные понятия, можно создать разнообразные схемы оформления чертежной документации. Мы ограничимся оформлением чертежей в соответствии с российскими стандартами, для чего придадим абстрактным понятиям необходимую конкретику.
Под книгой чертежей будем понимать совокупность графической документации проекта. Каждый чертеж разместим на листе соответствующего формата. В соответствии с принятым решением составим следующий план оформления документации.
1. Создание и настройка книги чертежей.
2. Создание и настройка шаблонов листов чертежей (форматов).
3. Формирование документации (размещение видов на соответствующих форматных листах).
4. Вывод документации.
Создание и настройка книги чертежей
В главе 2 упоминалось о том, что палитра Navigator (Навигатор) позволяет просматривать структуру проекта с помощью вариантов просмотра – карт. Для создания и просмотра иерархической структуры документации проекта предназначена карта Layout Book (Книга чертежей), для активации которой необходимо нажать кнопку
расположенную на панели инструментов навигатора, – на панели навигатора появится структура чертежей документации.
Структура чертежей начинается с корневой папки, которой является книга чертежей, носящая наименование, совпадающее с названием проекта. Дальнейшее расположение элементов структуры зависит от ее типа, который выбирается с помощью кнопки, расположенной под панелью навигатора.
Существует два следующих типа расположения элементов структуры.
□ Tree by subset (По подмножествам) – при выборе этого типа отображается создаваемая пользователем структура папок, в которые помещаются листы чертежей, в свою очередь являющиеся папками для размещенных на них видов (рис. 10.6, а). Последняя папка структуры – Masters (Шаблоны) содержит листы шаблонов чертежей.
□ Tree by master (По шаблонам) – основу структуры составляют листы шаблонов, которые являются папками для связанных с ними листов чертежей (рис. 10.6, б).
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Рис. 10.6. Варианты структуры книги чертежей
Для работы с создаваемой или имеющейся структурой используется контекстное меню, вызываемое щелчком правой кнопкой мыши на элементе структуры. Однако можно использовать следующие кнопки, расположенные под рабочим полем структуры чертежей:
Settings (Параметры) – вызывает окно настройки параметров выбранного элемента структуры;
New Layout (Создать лист) – создает новый лист чертежа;
New Master Layout (Создать шаблон) – создает новый шаблон;
New Subset (Создать подмножество) – создает подмножество чертежей (новая папка в структуре документации проекта);
Update (Обновить) – обновляет изображение выбранного чертежа.
Состав элементов управления, расположенных под рассмотренными кнопками, зависит от выбранного объекта и предназначен для управления их свойствами.
Окно настройки параметров книги чертежей (рис. 10.7) можно вызвать одним из следующих способов:
□ командой Book Settings (Параметры книги чертежей) контекстного меню корневой папки;
□ нажатием кнопки Settings (Параметры), расположенной в нижней части окна навигатора, при выделенной корневой папке структуры чертежей;
□ нажатием кнопки
при выделенной корневой папке структуры чертежей.
Рис. 10.7. Окно настройки параметров книги чертежей
Единственная задача настройки книги чертежей – установка нумерации ее объектов. Эта задача решается использованием следующих элементов управления:
□ переключателя выбора структуры нумерации чертежей, который можно установить в два положения:
■ Use Hierarchy (Tree View by Subset) (Использовать иерархию с подмножествами чертежей) – в этом положении нумеруются созданные подмножества, а их номера включаются в номера расположенных в них чертежей;
Use Flat Layout Order (Использовать обычный порядок чертежей) – нумерация папок подмножеств отсутствует, а номера чертежей не включают номера подмножеств;
□ текстового поля ID Prefix (Префикс идентификатора) – здесь определяется наличие и вид префикса, который подставляется в начало номера чертежа;
□ открывающегося списка ID Style (Стиль идентификатора) – элементами списка являются различные формы нумерации;
□ текстового поля Start at (Начать с) – здесь вводится начальный номер (или символ в случае выбора упорядочения по алфавиту), с которого должна начинаться нумерация чертежей.
В качестве примера создадим книгу чертежей проекта и определим ее структуру. Не обращайте внимания на имеющуюся структуру чертежей, а лучше удалите ее. Пока не трогайте шаблоны, расположенные в папке Masters (Шаблоны). Чтобы создать книгу чертежей проекта, необходимо выполнить следующие действия.
1. Открыть карту Layout Book (Книга чертежей), нажав кнопку панели навигатора.
2. Установить тип структуры отображения Tree by Subset (По подмножествам).
3. Вызвать окно установки параметров книги чертежей.
4. Установить в положение Use Flat Layout Order (Использовать обычный порядок чертежей) переключатель выбора структуры нумерации чертежей.
5. В текстовое поле ID Prefix (Префикс идентификатора) ввести префикс номера чертежа Пр.17 -.
6. Из открывающегося списка ID Style (Стиль идентификатора) выбрать форму нумерации 01, 02, 03.
7. В текстовое поле Start at (Начать с) ввести 1.
8. Последовательными нажатиями кнопки
и вводом соответствующего наименования в текстовое поле открывающегося диалогового окна создать подмножество чертежей Планы, Фасады, Общий вид, Деталировка.
ВНИМАНИЕ
Не забывайте после создания подмножества делать активной корневую папку, иначе очередное подмножество будет создаваться внутри уже созданного.
В данной главе рассматривались инструменты и технологии подготовки устройств вывода и выводимых изображений для получения полного комплекта проектной документации.
Основным вопросом, рассмотренным в этой главе, была подготовка документации проекта, оформленной в соответствии с принятыми государственными или корпоративными стандартами. Прочитав изложенный в главе материал, вы научились создавать и настраивать книгу чертежей, формировать выходную документацию из разработанных в проекте и внешних видов, рисунков и чертежей.
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Создание и редактирование лестниц
Источники света
Общие сведения о слоях
Управление слоями
Комбинации слоев
Создание слоев и комбинаций слоев
Меню работы со слоями
Нанесение линейных размеров
Настройка параметров линейных размеров
Построение линейных размеров
Нанесение радиальных размеров
Настройка параметров радиальных размеров
Построение радиальных размеров
Нанесение угловых размеров
Настройка параметров угловых размеров
Построение угловых размеров
Нанесение отметок возвышений на разрезы/фасады
Построение отметок возвышений на разрезах / фасадах
Нанесение отметок возвышений на план этажа
Настройка параметров отметок возвышений на плане этажа
Построение отметок возвышений на плане этажа
Выносные надписи
Построение выносных надписей
Редактирование выносных надписей
Глава 9 Визуализация элементов проекта: двумерные изображения
Деталировочные чертежи
Настройка параметров деталировочных чертежей
Построение деталировочных чертежей
Рабочие листы
Вставка изображений
Настройка параметров вставки изображений
Вставка и редактирование изображений
Глава 10 Вывод чертежей на печать
Вывод на плоттер
Настройка плоттера
Вывод на принтер
Настройка принтера
Оформление документации
Создание и настройка книги чертежей